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Preface

Introduction
This guide contains essential information about configuring and operating Kofax Import Connector.

This guide assumes that you have a thorough understanding of Windows standards, applications,
and interfaces. It also assumes that you have a thorough understanding of the Internet, your network
configuration, and Kofax Capture.

This guide is for system administrators who are configuring and operating Kofax Import Connector, or who
need a description of the configuration procedures and operation.

Related Documentation
The full documentation set for Kofax Import Connector is available at the following location

https://docshield.kofax.com/Portal/Products/en_US/KIC/2.7.0-wxv16nxbqj/KIC.htm

In addition to this guide, the documentation set includes the following items:
• Kofax Import Connector Installation Guide
• Kofax Import Connector Developer's Guide
• Message Connector Help
• KC Plug-In Help
• Release notes

Help
The online Help systems included in Kofax Import Connector provide online assistance for system
administrators and operators alike. You can access online Help from any application window by clicking
Help.

Release Notes
Late-breaking product information is available from release notes. You should read the release notes
carefully, as they contain information that may not be included in other Kofax Import Connector
documentation.
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Training
Kofax offers both classroom and computer-based training that will help you make the most of your Kofax
Capture solution. Visit the Kofax website at www.kofax.com for complete details about the available
training options and schedules.

Get help for Kofax products
Kofax regularly updates the Kofax Support site with the latest information about Kofax products.

To access some resources, you must have a valid Support Agreement with an authorized Kofax Reseller/
Partner or with Kofax directly.

Use the tools that Kofax provides for researching and identifying issues. For example, use the Kofax
Support site to search for answers about messages, keywords, and product issues. To access the Kofax
Support page, go to www.kofax.com.

The Kofax Support page provides:
• Product information and release news

Click a product family, select a product, and select a version number.
• Downloadable product documentation

Click a product family, select a product, and click Documentation.
• Access to product knowledge bases

Click Knowledge Base.
• Access to the Kofax Customer Portal (for eligible customers)

Click Account Management and log in.
To optimize your use of the portal, go to the Kofax Customer Portal login page and click the link to
open the Guide to the Kofax Support Portal. This guide describes how to access the support site, what
to do before contacting the support team, how to open a new case or view an open case, and what
information to collect before opening a case.

• Access to support tools
Click Tools and select the tool to use.

• Information about the support commitment for Kofax products
Click Support Details and select Kofax Support Commitment.

Use these tools to find answers to questions that you have, to learn about new functionality, and to
research possible solutions to current issues.
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Chapter 1

Overview

Kofax Import Connector is an add-on to Kofax Capture responsible for importing messages and files in
many electronic formats.

It has two main components:
• Message Connector is usually installed on a standalone computer. It retrieves documents from various

sources, converts them to Kofax Capture compatible format and saves them in its internal storage.
• KC Plug-In is installed at the Kofax Capture computer. It connects to one or more Message Connectors

and imports documents to Kofax Capture for further processing.

Kofax Import Connector can import messages and files from many sources:
• email messages including attachments using various email protocols (SMTP, POP3, IMAP, EWS)
• fax messages (via internal fax over IP server or external fax servers: Kofax Communication Server,

RightFax, Biscom)
• files from a local or network folder
• files via web services

This guide provides important information about configuring and operating Kofax Import Connector,
including:
• Instructions for configuring Kofax Import Connector
• Instructions for integrating with third party environment, such as fax servers or email servers
• Instructions for operating and monitoring Kofax Import Connector

Concepts
Kofax Import Connector uses a unified workflow for documents from all sources. Older import connectors
have used various approaches for importing documents to Kofax Capture. This section describes the
concepts that you need to understand before configuring Kofax Import Connector.
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Storage
Before importing to Kofax Capture, documents from all sources are saved to the internal storage of
Message Connector. KC Plug-In periodically polls all connected Message Connectors and imports the
documents to Kofax Capture. Processed documents in the storage are automatically deleted when the
space is required for new documents. Administrators can access the documents in the storage; refer to
View messages in the storage and Manage failed messages manually.

Conversion
Message Connector can convert the documents from the storage before importing them to Kofax Capture.
The conversion tools have to be installed on the same computer as Message Connector. Refer to Kofax
Import Connector Installation Guide.

Destination
Destinations tell Kofax Capture how it should handle documents received from Kofax Import Connector.
In a destination, you select things like the desired document conversion, what part of document do you
want to import (e.g. only attachments in case of emails), what batch class to use, and much more. You
can also map metadata of imported documents to Kofax Capture batch / folder / document fields. Refer to
Configure destinations for imported documents.

Connection between Message Connector and Kofax Capture
The KC Plug-In component of Kofax Import Connector is directly integrated with Kofax Capture. The
Message Connector is usually installed on another computer. However, these two components must
communicate. Therefore, a connection to Message Connector must be defined in KC Plug-In. Refer to 
Connect KC Plug-In to Message Connector.
You can also define how often should KC Plug-In poll for new documents and you can restrict the
operating time of this connection. Even when the connection is inactive, documents delivered via SMTP
email, fax over IP, and web service are accumulated in Message Connector storage.
When you define a connection, you must select the default destination. All documents are handled
accordingly... unless you specify different rule.

Rule
Formerly called destination mappings in Kofax Capture Import Connector - Advanced Email and Fax,
rules allow you to filter documents and assign them to destinations. Rules override the default destination
of a connection. For example, you can decide that all email messages go to destination 1. All faxes from
number starting with 123 use destination 2. Refer to Configure rules.
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Chapter 2

Configuration

This chapter lists the most common tasks necessary to configure Kofax Import Connector.

The tasks below do not mention all parameters; you can configure much more than what’s listed here. The
Message Connector configuration utility shows a brief description of all parameters inline. The KC Plug-In
offers tooltips. All parameters are described in the online help.

A general procedure for configuring Kofax Import Connector is here:
1. Add at least one batch class to Kofax Capture and publish it. Refer to Kofax Capture documentation

for information about batch classes. If you want to use sample batch classes, refer to Import batch
classes.

2. Optionally, if you want to differentiate between XML documents and handle them differently, you can
define XML types. Kofax Import Connector can identify XML documents with a particular namespace
and root element. Refer to Configure XML types.

3. Create a destination using a batch class and, optionally, an XML type. Refer to Configure
destinations for imported documents.

4. Connect KC Plug-In to Message Connector. Refer to  Connect KC Plug-In to Message Connector.
5. Select and configure one or more sources to import documents from:

• Import via fax over IP. Refer to Configuring Message Connector as FoIP Server.
• Import via SMTP. Refer to Configure Message Connector as SMTP Server.
• Import via web services. Refer to Configure Message Connector for web service input.
• Import from an IMAP, POP3, or EWS mailbox. Refer to Access mailboxes (IMAP, POP3, EWS).
• Import from a folder. Refer to Access folders.
• Import from a fax server. Refer to Access fax servers.

6. Optionally, if you want to differentiate how to handle specific messages, add rules that change the
default destination. Refer to Configure rules.

7. Set up the tools for document conversion. Refer to Configure document conversion.
8. Select what to do in case of failures. Refer to Manage failed messages manually.
9. Start the KC Plug-In service. Refer to Start and Stop the KC Plug-In Service.

Configure incoming documents
Use this chapter to configure:
• From where should Kofax Import Connector import documents (e.g., email, fax, folder)
• What tools should be used for converting documents
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Configuring Message Connector as FoIP Server
Message Connector can act as a fax over IP device and accept incoming faxes. To receive faxes, fax over
IP infrastructure must be available and configured properly.

1. On the KC Plug-In computer, create or edit a connection between KC Plug-In and Message
Connector. Click Add and select FoIP Import to add fax over IP to the list of import connectors.
Refer to  Connect KC Plug-In to Message Connector.

2. Contact the administrator of your fax over IP network. On the FoIP gateway, the IP address of
Message Connector must be assigned an extension. In the ideal case, no further configuration is
necessary and faxes sent to that extension will automatically end up in Message Connector storage.
If not, proceed with the next steps.

3. Start Message Connector Configuration utility from the Kofax Import Connector group in the
Windows Start menu.

4. Optionally, on the General tab, enter the Own Fax Number. This number is displayed on the fax
device that sends a fax to you as your fax number.

5. Click Advanced to display additional configuration options.
6. On the Security Options tab, verify that Disable FoIP is not selected.
7. On the List of Call Peers tab, specify the protocol supported by your FoIP gateway (H.323 or

SIP, with or without registration), its IP address and port, and other parameters as required by the
gateway.

Note By default, H.323 protocol is not enabled.

8. Review the settings in the tabs VoIP/FoIP Network, Voice Codecs, Fax, H.323 Signaling, and SIP
Signaling.

9. Click Save. Click Exit and restart service.

Connect KC Plug-In to Message Connector
A single instance of KC Plug-In can connect to multiple Message Connectors.

At least one destination must exist before connecting to Message Connector. Refer to Configure
destinations for imported documents.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. On the Connection Tasks menu, click Add Connection.
3. Enter a descriptive Connection name.
4. Change the Message Connector URL to your installed Message Connector host name.
5. If a password for the Process user is configured in Message Connector, enter it into the Password

field (blank by default).
6. Click Test Connection to verify that KC Plug-In can connect to Message Connector.
7. Select a Default Destination.
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Note The default destination must not have an XML type specified.

8. Enable one or more import connectors to tell Kofax Import Connector what kind of documents should
it import:

a. Click Add and select SMTP Import to enable import via SMTP email. Refer to Configure
Message Connector as SMTP Server.

b. Click Add and select Web Service Import to enable import via web service interface. Refer to
Configure Message Connector for web service input.

c. Click Add and select FoIP Import to enable import via fax over IP. Refer to Configuring
Message Connector as FoIP Server.

d. Click Add and select Mailbox Import to enable importing of POP3, IMAP, and EWS email.
Refer to Access mailboxes (IMAP, POP3, EWS).

e. Click Add and select Fax Server Import to enable importing of fax messages from compatible
fax servers. Refer to Access fax servers.

f. Click Add and select Folder Import to enable importing of documents from a local or network
folder. Refer to Access folders.

You can add and operate multiple import connectors in parallel (up to 100). However, you can select
FoIP, SMTP, or web service import only once.

9. Click OK. Restart the KC Plug-In service.

Note Connecting multiple KC Plug-Ins to a single Message Connector is not supported.

Configure Message Connector as SMTP Server
Message Connector can act as an SMTP gateway and accept incoming SMTP emails.

1. Start Message Connector Configuration utility from the Kofax Import Connector group in the
Windows Start menu.

2. Go to the General tab and enter the Own Computer Name (might be necessary for SSL).
3. Optionally, on the Email Inbound via SMTP tab, specify the Local IP Address (IP address of the

used network adapter; required e.g. in clustered environment) and port. You can also enable SSL.
4. Verify that SMTP input is not disabled:

a. Click Advanced.

b. Go to the Security Options tab.

c. Make sure that Disable SMTP Server is not selected.
5. Click Save. Click Exit and restart service.
6. On the KC Plug-In computer, create or edit a connection between KC Plug-In and Message

Connector. Click Add and select SMTP Import to add SMTP email to the list of import connectors.
Refer to  Connect KC Plug-In to Message Connector.

7. Next, you need to configure your email server (e.g. Microsoft Exchange) to forward messages to
Message Connector via SMTP. Contact your mail server administrator.

E.g., with Microsoft Exchange 2010, use a new logical domain (e.g. user1@kic.ed.com) and create a
send connector for this domain. The address space of the send connector must contain the domain (e.g.
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kic.ed.com). Then configure the Message Connector (e.g. 192.168.10.10) as smart host for the new send
connector. Exchange users can now send to all addresses in the domain kic.ed.com.

For testing, you can configure Message Connector’s IP address as the outgoing SMTP server in your
mail client software. As a mail client, you can use e.g. Mozilla Thunderbird or Windows Live Mail. In the
examples below, 172.20.148.110 is the IP address of Message Connector.

In Thunderbird, set up a new outgoing SMTP server, then create a new account and choose the new
SMTP server.

In Live Mail, select to manually configure server settings and specify the outgoing server address.
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An even simpler test email can be sent via the Message Connector monitor tool. Refer to Send a test
email.

Configure Message Connector for web service input
Message Connector can accept documents via web services.

1. Start Message Connector Configuration utility from the Kofax Import Connector group in the
Windows Start menu.

2. Go to the General tab and enter the Own Computer Name (might be necessary for SSL).
3. Go to the Web Service Input tab.

a. Specify Local IP Address (IP address of the used network adapter; required e.g. in clustered
environment).

b. Make sure that either HTTP or HTTPS port has a non-zero value.

c. Optionally, if you want to use the web service calls GetContentTypeList and
GetContentTypeDescription to retrieve information from Kofax Capture, specify KC Plug-In
URL, e.g. http://localhost:8001/KIC-Electronic-Documents. The URL must include the same
port number as the one configured in KC Plug-In. Refer to Configure KC Plug-In web service
interface.

4. If you are using network load balancing and you want to track the status of documents send via
web service, different instances of Message Connector need to communicate together. You need to
configure additional parameters on each computer:

a. Select MC Cluster Enabled to enable the communication between Message Connectors in
order to track documents.

b. In the Local MC Cluster IP Address field, enter the local IP address. This address must be
reachable from other Message Connector computers.

c. In the MC Cluster Port field, enter the port for internal communication between Message
Connectors.

d. In the MC Cluster Members field, list the IP addresses and ports of other Message
Connectors, e.g. "10.10.10.1:25099, 10.10.10.2:25099".

5. Verify that web service input is not disabled:

a. Click Advanced.
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b. Go to the Security Options tab.

c. Make sure that Disable Web Service Input is not selected.
6. Click Save. Click Exit and restart service.
7. On the KC Plug-In computer, create or edit a connection between KC Plug-In and Message

Connector. Click Add and select Web Service Import to add web service to the list of import
connectors. Refer to  Connect KC Plug-In to Message Connector.

Customers must provide their own application to send documents to Kofax Import Connector via web
services interface. The WSDL file describing the interface is available in the installation directory (by
default <programs>\Kofax\KIC-ED\MC\web\import.wsdl).

A sample application for sending documents is available on the installation ISO: Samples\WebService
\CSharpClient.zip. Both source code and compiled application are provided. For more information about
using the tool, refer to readme.txt (part of the zip package). For additional information about the interface,
refer to Kofax Import Connector Developer's Guide.

The web services interface is not compatible with Kofax Capture Import Connector - Web Services.
Existing customer applications have to be updated.

Access mailboxes (IMAP, POP3, EWS)
1. Start KC Plug-In configuration. Do one of the following

• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic
Documents group in the Windows Start menu.

• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic
Documents > Configuration.

2. Connect KC Plug-In to a Message Connector or edit one of the existing connections. Refer to 
Connect KC Plug-In to Message Connector.

3. In the Connection configuration window, click Add and select Mailbox Import.
4. Enter a descriptive Display name.
5. In the "Poll cycle in seconds" field, specify how often should the mailbox be checked for new

documents. The maximum value is 86400 seconds, i.e. 24 hours.
6. In the Host field, enter one of the following:

• Host name or IP address of the IMAP/POP3 server, e.g. pop3.gmail.com
• URL of the Exchange Web Services end point in the format http[s]://<host>[:port]/ews/

exchange.asmx
7. Select the Protocol for accessing the mailbox.
8. For EWS/IMAP protocol, specify the folder name in Poll mail box to poll messages. Select Poll sub

folders to poll the messages from sub folders as well. To poll a public folder's subfolders for EWS,
specify the folder path till at least one sub folder. For example, Public Folders\xyz, All Public Folders/
TestPublicFolder01. It is necessary to specify the applicable root public folder name (such as Public
Folders\xyz, All Public Folders) in the path.
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Note
• You can configure the level for polling of nested sub folders. To configure the level of sub folder

for polling, modify the parameter MaxFolderIdViewNum in the file Create_Config.xslt available at
C:\Program Files (x86)\Kofax\KIC-ED\MC\xcd (for default installation path on a 64-bit
operating system.) For example, if you set MaxFolderIdViewNum parameter to 25, subfolders till
25 level deep are polled.

• Polling nested sub folders can result in lower performance.
• The path delimiter in a mailbox folder path may vary with the protocol selected and the

mail server in use. Please use the path delimiter which is applicable to your environment.
For example, Gmail and Exchange servers use slash "/" as a folder delimiter (Inbox/
Subfolder1/Subfolder2) and Lotus Notes uses backslash "\" as a folder delimiter (Inbox
\Subfolder1\Subfolder2).

9. For IMAP and EWS, you can additionally configure how processed messages should be handled. If
you select to Keep messages on server, you must specify a Processed folder name. Processed
messages will not be deleted from the server, instead, they will be moved to the specified folder. For
IMAP, processed messages can be moved to an existing sub folder as well.

10. To enable impersonation, select Enable Impersonation, and configure the user credentials in one of
the following formats:
• domain\user\mailbox

• \user@domain.com\mailbox@domain.com

• domain\user@domain.com\mailbox@domain.com

Where, domain is the domain name, user is the user having impersonation rights, and mailbox
is the name of the mailbox to access. The mailbox can be a user's mailbox or a service account's
mailbox.

11. For IMAP and EWS, select the Mode which determines whether the same inbox can be polled by
multiple Message Connectors simultaneously.
• Select Single Instance if you know that you will poll this mailbox with only one Message

Connector. Using this value and running multiple connections in parallel might cause that the
same message is imported to Kofax Capture multiple times.

• Select Multiple Instance to allow multiple connections to a single mailbox, without risking
duplicate imports. However, not all IMAP servers support this option (rename inbox function). The
Test Mailbox button verifies if this option is available on your IMAP server.

12. Enter the credentials in User name and Password.

Note Do not use angular bracket (<, >) characters in your Exchange Server password as it may
cause a connection failure with the mailbox.

13. Click Test Mailbox to verify the connection. Click OK to close the folder settings window.
14. Click OK to close the connection configuration window. Restart the KC Plug-In service.
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Additional parameters related to POP3/IMAP/EWS import are available in the Message Connector
configuration, in the Security Options tab.
• Disable POP3/IMAP - If you need to disable the polling of POP3/IMAP completely.
• Disable EWS - If you need to disable the polling of EWS completely.

Note Message Connector
Message Connector receives a message via POP3, it always tells the POP3 server to delete the
message. However, POP3 servers can be configured to perform a different action when a delete is
requested, e.g. they move the message to a different folder. This behavior is mail server specific and
cannot be controlled by Kofax Import Connector.

Also, it is not recommended to poll a single POP3 mailbox from multiple Message Connectors. While a
strict implementation of the POP3 protocol should allow a reliable locking mechanism needed to prevent
reception of duplicates, many common POP3 email providers lack these.
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Access folders
1. Start KC Plug-In configuration. Do one of the following

• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic
Documents group in the Windows Start menu.

• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic
Documents > Configuration.

2. Connect KC Plug-In to a Message Connector or edit one of the existing connections. Refer to 
Connect KC Plug-In to Message Connector.

3. In the Connection configuration window, click Add and select Folder Import.
4. Enter a descriptive Display name.
5. In the "Poll cycle in seconds" field, specify how often should the folder be checked for new

documents. The maximum value is 86400 seconds, i.e. 24 hours.
6. Enter the Watched folder, either by typing the path or via the Browse... button. Use UNC syntax for

network paths.
7. In the User and Password fields, enter the Windows credentials needed for accessing the watched

folder. The user accessing the watched folder needs Modify or Full Control rights.

Note From one computer, only a single Windows user may access a network folder simultaneously.
If you have another connection active (e.g., a Windows Explorer window displaying the folder)
with a different user, Message Connector might have trouble accessing the folder (especially if the
active user does not have sufficient rights).

8. Click Test folder import to verify that Kofax Import Connector can connect to the specified folder. (If
you are testing a network folder, having a Windows Explorer window open displaying the content of
the folder might occasionally prevent the test button to connect.)

9. Optionally, go to the Advanced tab to configure additional parameters. If not, continue with step 15.
10. Select Process subfolders to monitor the immediate subfolders of the watched folder. Select

Include watched folder to monitor the watched folder itself. In Maximum subfolder level, configure
the level of nested subfolders to process. If 0 is selected in this field, no subfolders are processed.

Note In Windows operating system, the maximum valid path length is 260 characters. If the
number of characters in the path exceeds this limit, the path is considered invalid and the files are
not imported.

11. To delete the empty subfolders after importing the files, select Delete empty folder structures.
12. In the File mask field, enter a comma separated list of files that should be imported from the folder.

You can use wildcards: The asterisk character ("*") substitutes for any zero or more characters, and
the question mark ("?") substitutes for any one character. If you are using trigger files, this field is
disabled (see below).

13. Select the File Detection Mode. Use this setting to make sure that files are completely copied to the
watched folder before importing. Select one of the options:
• Select File not modified since to force Kofax Import Connector to wait for the specified number

of seconds after the file was last accessed.
• Select Use trigger if you want first copy a document (or a folder containing documents) to the

watched folder and then create a trigger file that tells Kofax Import Connector that the document
(or folder) is ready for importing.
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14. If you selected to use trigger files:

a. In the Trigger file mask field enter a trigger file, e.g. "*.trg" (or a comma separated list of trigger
files). You can use wildcards: The asterisk character ("*") substitutes for any zero or more
characters, and the question mark ("?") substitutes for any one character.

b. Decide whether the trigger refers to documents or folders:
• Select Files in the same directory with the same base name. Kofax Import Connector cuts

the extension from the trigger file name and searches for documents with the same base
name in the same folder. For example, with trigger file mask "*.trg" and trigger file "001.trg",
all documents matching "001.*" (except the trg file) are imported.

• Select All files in the same directory to import all documents from the same folder (except
the trigger file). For example, when the trigger file ready-to-be-imported.trg appears in a
watched folder, all other documents in the folder are imported to Kofax Import Connector.

• Select All files in the subfolder with the same base name. Kofax Import Connector cuts
the extension from the trigger file name and searches for a subfolder with the same name. All
documents from the subfolder are imported.

Note The trigger file must have an extension.

• Select Import all files in a folder matching file mask. Kofax Import Connector looks for
a folder with name that matches the trigger file mask. All documents from the folder are
imported.

c. Decide what to do with the trigger files after import:
• Select Delete to delete it.
• Select Rename extension to and specify an extension to rename it.

d. Select Import trigger file if you want import the content of the trigger file. When cleared, the
content of the trigger file is not relevant and it is deleted/renamed after the other documents are
imported.

15. Select the File Import Mode. Use this setting to determine how XML documents should be handled.
• Select Automatic to tell Kofax Import Connector to parse the XML documents. If an XML

document is identified as one of the configured XML types, it will be handled accordingly. If
the document structure does not match any of the configured XML types, it is seen as a binary
document.

• Select Custom to restrict what type of XML is accepted. E.g., if you select only "Kofax Capture
XML", all incoming XML are treated as XML Import Connector compatible files.

16. Click OK to close the connection configuration window. Restart the KC Plug-In service.

Additional configuration options related to folder import are available in the Message Connector
configuration, in the Security Options tab.
• Disable Folder Import - If you need to disable the feature completely.
• Folder Input Base Directory - If you want to restrict which folder can be configured as the watched

folder.

Note Kofax Import Connector cannot import documents if the combined number of characters in file path
and file name exceeds 211. Also, the documents cannot have the read-only attribute enabled.
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When you import EML and MSG files via folder import, Kofax Import Connector keeps the metadata of the
email message, not the metadata of the file on disk.

Access fax servers
Before you connect to the fax servers, make sure that you have the necessary environment available.
• For Kofax Communication Server, refer to Connect to Kofax Communication Server.
• For RightFax server, refer to Connect to RightFax fax server.
• For Biscom server, refer to Connect to Biscom fax server

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. Connect KC Plug-In to a Message Connector or edit one of the existing connections. Refer to 

Connect KC Plug-In to Message Connector.
3. Click Add and select Fax Server Import.
4. In the Type field, select the fax server you want to connect to.
5. Enter a descriptive Display name.
6. Specify how often should Message Connector poll the fax server for new messages. The maximum

value is 86400 seconds, i.e. 24 hours.
7. Enter the host name of the fax server.
8. Enter the fax server login credentials.
9. For Biscom server, enter also the Windows credentials for accessing the file share.

10. Click Add to specify a user and/or extension. Fax messages to that user/extension will be imported
to Kofax Capture. Alternatively, select a user and click Remove to stop polling the user/extension.

11. Click Test fax server connection to verify that Kofax Import Connector can connect to the specified
fax server.

12. Click OK to close the fax server import settings window.
13. Click OK to close the connection configuration window. Restart the KC Plug-In service.
14. For connections to Biscom server when the Message Connector is installed on Windows XP and

Windows Server 2003 operating systems, the Message Connector service must be running under
the Windows account with local administration rights and write access on the Biscom server’s
network share.

a. Run services.msc on the Message Connector computer.

b. In Log On tab of the properties of the Message Connector service, specify the Windows
account.

c. Click OK to confirm the changes.

d. Restart the Message Connector service.
15. Make sure that support for RightFax or Biscom servers is not disabled in the Message Connector

configuration. Start the configuration, click Advanced. In the Security Options tab, verify that the
support for your fax server is not disabled.
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Note RightFax does not support access rights to users/extensions based on group membership via the
ComAPI (which is used by Kofax Import Connector). This works only for the client access. So either
RightFax Administrator login credentials have to be specified (which is not recommended) or enter as
login user the owner of the extension.

Rarely, messages from the RightFax cannot be imported to Kofax Capture, with the error "Compressed
data error" or "End of image encountered". As a workaround, enable image normalization, e.g. "Convert
to: TIF" and "Conversion Mode: Convert all content" and "Image format: 200 x 200 dpi". (SPR00092052)

Configure document conversion
Kofax Import Connector can convert text, HTML, OpenOffice.org and Microsoft Office documents to a
format readable by Kofax Capture. It can also convert images. Supported formats depend on the available
convertor tools. Refer to Kofax Import Connector Installation Guide for details.

1. Start Message Connector Configuration utility from the Kofax Import Connector group in the
Windows Start menu.

2. Expand the Document Conversion tab.
3. Select Enable Decompression if you want extract documents from compressed files. The following

formats/extensions are supported: zip, rar, 7z, tar, gzip. Extraction happens before regular document
conversion, i.e., a Word document extracted from a zip file can be further converted into PDF.
Extraction is repeated if the extracted file is another compressed file (e.g., zip within zip), until all
compressed files are extracted. Zip file containing multiple files with same name is also extracted.
The following restrictions apply:
• Password-protected compressed files are not extracted.
• Archives split to multiple volumes are not supported.
• EML documents from compressed files are not subject to further extraction/document conversion.
• If the extraction ends without error, the compressed file is discarded. When archiving to folder is

enabled, the extracted files are archived, not the compressed ones.
4. Select the tool for converting Microsoft Office documents.
5. Select the tool for converting HTML documents.
6. If you selected OpenOffice.org in step 3, make sure that you have installed the necessary extension.

Refer to the Installation Guide.
7. If you selected Microsoft Office in either step 3 or step 4, and you are using the operating system

Windows Server 2008, Windows Vista, or later, you need to select the Windows user account to be
used for Microsoft Office DCOM automation. For initial tests and troubleshooting, you may use the
interactive user. For production use, you must specify an administrator user.

8. Click Advanced. In the Security Options tab, verify that document conversion is not disabled.
9. Click Save. Click Exit and restart service.

These steps set up the general document conversion capabilities of a Message Connector. Use
destinations and rules to configure what document conversion should be performed for a particular
document. Refer to Configure destinations for imported documents and Configure rules.

Change maximum number of passive inputs
1. Close all KC Plug-In windows.
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2. Open the file KIC-ED-KCPlugin.xml from C:\ProgramData\Kofax\KIC-ED\KCPlugin\config\
in a text editor.

3. Change the value of the parameter MaxPassiveInputs. The default value is 100. The maximum
number of passive inputs is 400.

4. Save the changes.
When you start KC Plug-In configuration again, you can now configure up to the specified number of
passive inputs.

Configure processing in Kofax Capture
Use this section if you want to configure how to import messages into Kofax Capture and which batch
classes should be used.

Import batch classes
Two sample batch classes are installed with KC Plug-In. You can use the sample batch classes, or you
can create your own. The benefit of the sample batch classes is that they already have the message
metadata provided by with Kofax Import Connector mapped to Kofax Capture fields. Either way, a batch
class is necessary for successfully running Kofax Import Connector.

Note If you are using Kofax Capture Network Server, you can only to perform batch class configuration
on the central site.

1. Start Kofax Capture Administration module from the Kofax Capture group in the Windows Start
menu.

2. On the menu, select File > Import.
3. Browse to <programs>\Kofax\KIC-ED\KCPlugIn\BatchClass.
4. Open ElectronicDocumentsBatchClass.cab. Wait until the batch classes are unpacked. Click OK.
5. Click Add All, then click Import. Wait until importing is completed. Click OK.
6. Publish the new batch classes.

Configure XML types
Kofax Import Connector can be configured to identify XML documents with a particular namespace and
root element. The combination of a namespace and root element is referred as an XML type. Importing of
each XML type can be handled differently.

To define an XML type, you need to provide the XML schema definition file and a sample XML document.
XML types can be used in the following situations:
• The values of XML elements can be mapped to the batch / folder / document index fields of your batch

class. Refer to Use XSL transformation to map metadata and XML data.
• The values of XML elements can be rendered as a TIFF or PDF. Refer to Render XML documents.
• Additionally, XML types are used as filters in rules. Refer to Configure rules.
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Note There is a built-in XML type called ImportSession. The purpose of this XML type is to support the
standard Kofax Capture XML Import Connector compatible XML format. You do not need to import this
XML type, it is available automatically.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. Go to the XML Types tab.
3. On the XML Type Tasks menu, click Add XML Type.
4. Browse to your XML schema definition file (.xsd).
5. Browse to a sample XML file that uses the specified schema.

Now you can create a destination that uses this XML type. Refer to Configure destinations for imported
documents.

Additional information about custom XML types can be found in the Kofax Import Connector Developers
Guide.

Kofax Import Connector does not change the logical structure of the XML documents, but the text
presentation is often modified:
• The XML code page is changed to UTF-8.
• Insignificant whitespace can be removed or changed.
• Character quotes or CDATA sections can be removed or changed.

Validating XML Types in Message Connector
Message Connector can be configured to reject received XML documents that cannot be validated
against an XML schema. This feature is primarily useful for web service input, where the invalid document
is immediately rejected and the web service sender is informed about the reasons (failed validation).
However, it applies to documents from all connectors - non-valid XML will not be imported to Kofax
Capture.

1. Copy the folder C:\ProgramData\Kofax\KIC-ED\KCPlugIn\XMLTypes from the KC Plug-In computer
to the Message Connector installation folder (by default <programs>\Kofax\KIC-ED\MC\). You need
to repeat this step whenever you change the configured XML types in KC Plug-In.

Note The built-in XML type called ImportSession (standard Kofax Capture XML Import Connector
compatible format) is available on Message Connector automatically, i.e. if you are not using
custom XML types, you can skip this step.

2. Start Message Connector Configuration utility from the Kofax Import Connector group in the
Windows Start menu.

3. Go to the Structured (XML) Input Handling tab.
4. In the Types field, enter a comma or blank separated list of MIME types or file extensions that should

be treated as XML documents for the purpose of automatic schema validation. This setting applies to
import from email and folder (binary and XML file import mode only).

23



Kofax Import Connector Administrator's Guide

5. In the Schema Validation field, select one of the options:
• Select Disabled if you don't want Message Connector to validate XML documents. All incoming

XML documents will be handled according to the configuration in KC Plug-In.
• Select Optional if you want validate those XML documents for which an XML type has been

defined. Documents that have a defined XML type but are not valid are handled according to the
setting of the "If Validation Fails" parameter.

• Select Required if you want to validate all XML documents (a matching XML type must exist).
Documents that don't have a matching XML type as well as documents that fail validation are
handled according to the setting of the "If Validation Fails" parameter.

6. In the "If Validation Fails" field, select what to do when an XML document is not valid:
• Select Do not apply XML handling to treat the document as a non-XML document. It is also

marked with a document conversion error.
• Select Reject the message to mark the document as invalid. Such documents are not imported

to Kofax Capture. In case of web service input, the sender is immediately informed about the
reason of rejection. Even invalid documents are temporarily stored in Message Connector for
troubleshooting.

7. Click Save. Click Exit and restart service.

Configure EDI types
Kofax Import Connector can be configured to understand EDI documents (EDIFACT and X.12).

To define an EDI type, you need to provide an XML schema definition file and a sample XML document.
Kofax Import Connector is shipped with several predefined EDI types. Additional EDI types are available
for download. You can also use custom EDI types.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. Go to the EDI Types tab.
3. On the EDI Type Tasks menu, click Add EDI Type.
4. Browse to your XML schema definition file (.xsd). Do one of the following:

• Select one of the EDI types supported out of the box from
<installdir>\EDI\SampleConfigFiles\.

• Select one of the EDI types that you have downloaded from www.kofax.com.
• Select your custom EDI format.

5. Browse to a sample XML file that uses the specified schema.

Now you can create a destination that uses this EDI format. See Configure destinations for imported
documents.

For additional information and configuration steps about EDI import, see Import EDI files.
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Configure destinations for imported documents
Destinations tell Kofax Capture how it should handle documents received by Kofax Import Connector.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. On the Destination Tasks menu, click Add Destination.
3. On the Import settings tab, enter a Name of this destination. Optionally, add a description.
4. Optionally, select an XML or EDI Type if you want to restrict the destination to that particular XML/

EDI type (i.e., only XML documents with matching namespace and root element are accepted by this
destination).

Note The default destination cannot have an XML/EDI type.

5. Select the Import content of this destination, i.e. what parts of a document should be imported, and
their order. Optionally, you can select to import the original content or the complete message as EML.

6. Configure the Import Mode.
• Select what content do you want to convert (images versus non-image content), into which format

(TIFF, PDF), and select the scaling, resolution, and color of the converted image.

Note If you don't want to convert your documents, clear both TIFF and PDF, and select one or
more of the following options: Include original content, Include complete message as EML
file, Include complete message as MSG file. Then set Originals import mode either to Save
to disk or to Import into Kofax Capture.

• Select Message Rendering if you want to convert XML documents or metadata as images. Refer
to Render XML documents.

• Enable VRS to preprocess incoming documents. This option is recommended for improving the
quality of scanned images. Refer to Configure VRS. You can also process PDF documents in
VRS.

7. On the Import mappings tab, select the batch class and document class. Optionally, select a folder
class and form type.

Note The selected batch class can be overwritten if you are importing XML documents that contain
batch class information. If the batch class from the XML document does not exist in Kofax Capture,
the following error message is displayed in the Message Connector storage: Batch class
required for XmlAutoImport or generic Xml mapping does not exist.

8. Optionally, you can map metadata of the imported document to Kofax Capture batch / folder /
document fields. Do one of the following:
• Set XML mapping to None and use the table below to map metadata. For each batch / folder /

document field defined in the batch class, you can select a value. Refer to Message fields.
• Select XML mapping if you want to map metadata for XML documents using XML types. Refer to

Use XSL transformation to map metadata and XML data.
9. Optionally, on the Additional settings tab you can configure custom scripts and error handling.
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10. Optionally, on the Advanced Conversion and Import tab you can configure advanced PDF settings.
11. In Output PDF format, select the output format for normalized PDF files. (Default: PDF/A-1b)

Note
• In "Import settings" tab, make sure that at least one option is selected for the "Convert to" field.
• If "Normalize PDF documents to PDFA" option is not selected, the incoming PDF files are not

normalized to any of the selected format.
• If the input PDF file format is not compatible to be converted to the required output format, the

actual output format may be downgraded. For example, if the input file version is PDF 1.5 and
if the "Output PDF format" field is set to "PDF/A-1a", "PDF/A-2a" or "PDF/A-3a", the output
PDF format may be PDF/A-1b, PDF/A-2u or PDF/A-3u respectively. Following are some of the
scenarios wherein the PDF/A compliance level may be downgraded:
• If the input file contains text that is not extractable such as missing ToUnicode information, the

output file compliance level is downgraded. For example, PDF/A-2u is downgraded to PDF/
A-2b.

• If logical structure (tagging) information is missing in the input file, the compliance level is
downgraded to level B or U. For example, PDF/A-1a is downgraded to PDF/A-1b.

12. Optionally, on the Email Notification and Archiving tab you can configure sending notifications to
message originators and archiving of documents in a particular folder.

13. Click OK to create the destination. Restart the KC Plug-In service.

Note If you modify a batch class or form type used in an existing destination, the mappings might be
lost. You have to remap the fields.

Sending Email Notifications
Kofax Import Connector can send notifications about incoming documents to a fixed email address. These
notifications are available for all import connectors.

Additional notifications can be sent to the originator of email messages. This function is only available for
incoming email import (where the email address of the originator is known).

1. Create or edit a destination. Go to the Email Notifications and Archiving tab.
2. Decide what notifications do you need and select the appropriate option:

• Click Successfully imported for successfully created batches.
• Click Partially imported for batches created with problems (e.g. errors during document

conversion, faxes with reception error, documents failed during XML schema validation when the
option "Do not apply XML handling" is selected).

• Click Not imported when no batch has been created (e.g. invalid batch name, fax message
without image pages, invalid XML documents when "Reject Message" is selected, etc.).

3. Select Send email to originator if you want to send notifications about emails to the email sender.
4. Select Send message to and type the email address (you can add more than one email address) if

you want to send notifications about documents. Email addresses must be delimited by space.
5. Select Attach original message if you want to attach the original message (in eml format) to the

notification mail.
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6. Enter the subject (Subject) and the body (Message text) of the notification message. You can use
metadata from the original message when populating these fields. Doubleclick a line from the Fields
table to insert it into message text or subject.

7. Repeat steps 2 to 5 for other types of notification as needed.
8. Click OK.

Kofax Import Connector tries to deliver the notification email messages via SMTP. If all retry attempts
fail, there is no further notification. Active and processed notifications can be viewed with the Message
Connector Monitor (processed notifications are deleted when storage space is required for new
documents).

Note To send messages, Kofax Import Connector must know your outgoing SMTP server. Go to the
Message Connector configuration,  Email Outbound tab. Work with your email server administrator to
set these options.

Archiving Documents
Kofax Import Connector can save processed documents to a folder for archiving.

1. Create or edit a destination. Go to the Email Notifications and Archiving tab.
2. Decide what documents do you want to archive and select the appropriate option:

• Use Successfully imported for successfully created batches.
• Use Partially imported for batches created with problems, e.g. during document conversion.
• Use Not imported when no batch has been created (e.g. batch name is invalid).

3. Select Save to folder.
4. In the "Folder location" field, enter the fixed part of the path, e.g. C:\archive\ok\.
5. In the "Subfolder and file prefix" field, enter subfolder(s) and file prefix, e.g. {Import-Date-

Long}\{Batch-Id} _{Batchclass}\prefix_. {Batch-Id} must be always included in this field.
6. Select one of your configured connections to Message Connector and click Test to verify that the

destination folder is reachable.
7. Select at least one format that should be used for archived documents.

• File - archive the message body and all attachments in separate files
• EML - archive message body and the attachments as a single EML file
• XML - archive the message metadata as a single Kofax-specific XML file (an XML schema is

available on request)
8. Repeat steps 2 to 7 to set up archiving for different set of documents.
9. Click OK.

10. Additionally, in the Message Connector configuration, Security Options tab, it is possible to disable
archiving completely, restrict archiving to a specific folder, and to configure Windows user name and
password. These credentials are used to access the archiving folder. If these credentials are not set,
the archiving folder must be accessible for the Network Service user.
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Use XSL transformation to map metadata and XML data
Kofax Import Connector can parse incoming XML documents and/or the metadata of incoming messages
and use the information from them to populate message fields. XML documents can also include links to
other documents to be imported. There are three types of mapping:
• XML Import Connector compatible is a specific variant of the generic mapping. It is compatible with

the Kofax Capture XML Import Connector. It is only available if you select ImportSession as the XML
type for the destination. It maps the input XML data in the same way as XML Import Connector would
do.

• Simple mapping maps metadata and/or XML document data to the particular fields of the batch/folder/
document classes that are configured for the destination where the mapping occurs. It is not possible to
control the batch/folder/document class names through the input XML data.

• Generic mapping takes into account that the information on batch/folder/document classes may come
in along within the customer’s XML document (and the class names configured for the destination are
only used as fallback if the particular class name is missing). The XML format in generic mapping is not
restricted and it can be configured for virtually any customer XML data structures.

The mapping itself (for both simple and generic methods as well) is performed by the means of an XSL
transformation. The transformation file can be written manually by an XSLT expert or it can be generated
by any XML mapping visual tool (for example, Altova MapForce). These tools offer a user-friendly GUI,
can perform even complex XML mappings and the XSL transformation can be generated automatically.

Important: In this document, Altova MapForce tool is used to describe all XSL transformation. You can
use any other tool. This tool can be installed on any computer. Kofax Import Connector does not need this
at run time.

Prerequisite: You can write the XSL transformation file manually or can generate it using any XML
mapping visual tool, for example, Altova MapForce. Still, XSLT expertise is required to perform XML
mapping.

1. Before setting up XML mapping, at least one XML type must be defined; unless you are using the
XML Import Connector schema <ImportSession> - that is available automatically. Refer to Configure
XML types.

Note You don't need to specify an XML type if you only want to map document metadata.

2. Edit a destination. Refer to Configure destinations for imported documents
3. On the Import settings tab, select an XML Type (not necessary if you only want to map document

metadata).
4. On the Import mappings tab, configure XML mapping:

• Select XML Import Connector compatible for XML documents compatible with Kofax Capture
XML Import Connector. Continue with step 12.

• Select Simple to map XML data and message metadata to the batch/folder/document fields
assigned to the destination that you are currently editing.

• Select Generic if the information about batch/folder/document classes is included in the XML
document. The information from the XML overrides the destination settings. If the class names are
not specified in the XML, the settings of the destination are used. Generic is also necessary in the
following use cases:
• Kofax Tables should be filled with the content of the input XML
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• The content of any index field should be evaluated by an expression
• Other features possibly supported by the Kofax XML Import Connector format

5. Click Show files for Visual Designer to display the folder where Kofax Import Connector stores the
files required for mapping.

Note It is the same folder that contains the files for XML rendering.

6. If Altova MapForce is not installed locally, copy the entire folder to the Altova MapForce computer.
7. Open the .mfd project file in Altova MapForce.
8. Map XML data and metadata to Kofax Capture batch / folder / document fields.

9. Save the project file. On the File menu, click Save.
10. Save the result to an XSLT file. On the File menu, expand Generate code in and select XSLT 1.0.

You must save the file to the same directory where the .mfd file is located. Change the file name to
XmlMapping.xslt.

11. If Altova MapForce is not installed locally, copy the entire folder back to KC Plug-In computer (to the
original location).

12. Close the destination configuration window and restart KC Plug-In.

You can use other tools to generate the necessary XSL transformation file that governs metadata
mapping. Simple transformations can also be written using a text editor. Alternatively, you can also
contact Kofax to create the mapping for you. For additional information, refer to Kofax Import Connector
Developers Guide.
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Note When using the XML type "ImportSession", you do not need to create any XSL transformation.
The mapping is available automatically.

There is a significant difference in importing of document's body and attachments (including XML
document itself) between simple and generic mapping:
• With simple mapping all parts of a document are automatically handled according to the destination’s

configuration and then imported as pages in the same folder/document class (or loose pages) of the
batch. If you convert your content to TIF or PDF and select Include original content, the XML document
is imported as original XML and also rendered to TIF or PDF. Further, if you do not convert the content
and select Include original content, the original XML document is imported.

• With the XML Import Connector compatible generic mapping, the attachments are only imported if they
are explicitly linked in the XML file. The controlling XML file is never imported.

• When using the generic mapping, attachments (and the XML document itself) are only imported
if explicitly instructed in the XSL transformation. For additional information, refer to Kofax Import
Connector Developer's Guide.

Altova MapForce is a third-party software that requires a license. This software is not included with
Kofax Import Connector. Also, the licenses for Kofax Import Connector will not help you operating Altova
MapForce.

Render XML documents
Kofax Import Connector can be configured to render structured XML data as PDF and/or TIFF. Two basic
use cases are foreseen:
• Render incoming XML documents.
• Render only the metadata of any document as some kind of cover sheet.

The rendering itself is performed via an XSL transformation that has to be generated by the visual tool
called Altova StyleVision.

Important: In this document, Altova StyleVision tool is used to describe all XML rendering. You can use
any other tool. This tool can be installed on any computer. Kofax Import Connector does not need this at
run time.

1. Edit a destination. Refer to Configure destinations for imported documents.
2. Go to the Import settings tab.
3. If you want to render XML documents, select XML Type. (If you only want to create cover sheets

from document metadata, this is not required.)
4. Select Message rendering.
5. Select the preferred image type (TIFF or PDF), resolution and color.
6. Click Show Files for Visual Designer to display the folder where Kofax Import Connector stores the

files required for XML rendering.

Note It is the same folder that contains the files for XML mapping.

7. If Altova StyleVision is not installed locally, copy the entire folder to the Altova StyleVision computer.
8. Open the .sps project file in Altova StyleVision.
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9. Use the XML elements from the Schema Tree to create an XSLT style sheet that defines how
information should be organized in PDF/TIFF format.

Note If Altova StyleVision is not installed locally and you add graphics (images) to the style sheet,
copy them to the folder where the project file (*.sps) is located. When importing the graphics, make
sure that you are using relative paths (clear the Absolute Path checkbox).

10. Save the project file. On the File menu, click Save.
11. Save the result to an XSLT file. On the File menu, expand Save Generated Files and select Save

Generated XSLT RTF File. You must save the file to the same directory where the .sps file is
located. Change the file name to Render.xslt.

12. If Altova StyleVision is not installed locally, copy the entire folder back to the KC Plug-In computer (to
the original location).

13. Optionally, click Preview to view how a rendered XML document (or metadata) will look like.
14. Close the Destination configuration window and restart KC Plug-In.
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Altova StyleVision is a third-party software that requires a license. This software is not included with
Kofax Import Connector. Also, the licenses for Kofax Import Connector will not help you operating Altova
StyleVision.

Configure VRS
VRS is used to improve the quality of incoming images in order to make it easier for Kofax Capture to
understand them. In Kofax Import Connector, each destination can have its own VRS settings.

However, you can use the image conversion of import connector to modify the resolution/color of an
image and then use VRS for further processing.

1. Edit a destination. Refer to Configure destinations for imported documents.
2. Go to the Import settings tab.
3. Optionally, configure color conversion or image scaling that should occur before VRS.
4. Select one of the VRS options:

• Select VRS only original images content if want to apply VRS processing to documents that
reached the import connector in image format (but not to documents that were converted to image
format by import connector).

• Select VRS all images if you want to apply VRS settings to all images. This means that also those
documents that were converted to image format by import connector are processed by VRS.
Usually, this is not recommended for Word or Excel documents. Also, use this option if you want to
apply VRS to PDF documents.

• Select None to disable VRS for all content.
5. Select Use VRS engine for PDF to TIFF conversion if you want to convert PDF documents to TIFF

format using VRS.

Note You must select PDF as your Convert to format to use this feature. Otherwise the PDF is
converted to TIFF before reaching VRS.

This option allows you to process larger PDF documents.
6. Click VRS Settings. The VRS Settings window is displayed.

The window is divided into 4 main parts:
• The top left part shows a sample image.
• The top right part shows the sample image after VRS processing.
• The bottom left part shows the menu.
• The bottom right part lists the various VRS parameters.

7. Configure the VRS parameters and test them:

a. Click Open File for Testing and select an image.

b. Modify the VRS parameters.

c. Click Test Current Settings to see the results of VRS processing.

d. Use the commands from the View menu to modify the zoom and switch pages (for multipage
TIF documents).

e. Repeat steps b to d until you are satisfied with the results.
8. Click Save VRS Parameters to apply the changes for this destination.

32



Kofax Import Connector Administrator's Guide

9. Optionally, click Save VRS Parameters to Profile if you want to reuse the same settings in other
destinations; or for backup.

Note All VRS profiles are stored in the file KCIC ElectronicDocuments KC Plug-In VRSProfiles.xml
in the folder %ALLUSERSPROFILE%\Kofax\KCIC - Electronic Documents\KC Plug-In
\Config\. Take this file if you need to transfer your profiles to another computer.

10. Click Exit to conclude VRS configuration.

Enabling VRS Multithreading
If you are using VRS exclusively for processing TIF files, you can enable VRS to work with multiple
connections.

1. Open the file KIC-ED-KCPlugin.xml from the folder C:\ProgramData\Kofax\KIC-ED\KCPlugIn
\config in the text editor.

2. Change the value of the parameter VRSMultiThreadingSupport from false to true.

Option Description

False (default) If you are using a single connection, you can
use VRS for both TIF and PDF. If you are using
multiple connections, VRS fails for both TIF and
PDF.

True For TIF, VRS can now be used with multiple
connections. However, for PDF, VRS always
fails.

3. Save the file and close it.

Configure rules
Each configured Message Connector has a default destination. Rules are used to filter documents and
assign them to different destinations. For example, email messages from a particular recipient can be
handled differently than documents imported from a folder.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. On the Connection Tasks menu, click Add Rule. Alternatively, select one of the existing rules and

click Edit Rule.
3. In the Service filter field, select one of the services if you want to filter documents depending on how

they reach Message Connector; e.g., via email or fax.
4. In the Recipient list field, enter the original recipient (as specified by the message sender). You can

use the asterisk wildcard * to specify all addresses. You can add multiple recipients, separated by
comma.
• For emails, specify an email address from the To or Cc list, such as john@kofax.com. This also

applies to MSG and EML files imported via folder import.
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• For faxes, specify the extension number on the fax server, such as 555*, 444*, 3333.
• For other import connectors, this filter is not available.

5. In the Address field, type the address from which Message Connector received the document. You
can use the asterisk wildcard * to specify all addresses. The wildcard is supported at the beginning or
at the end of the string.
• For POP3/IMAP mail, specify a mail box name, such as john@kofax.com.
• For EWS email, specify a mail box name, such as lena@kofax.com or asia\rajesh.
• For SMTP email, specify the final routed email address, such as *@kofax.com.
• For faxes, specify the user name on the fax server, such as biscom_user1.
• For FoIP, specify the extension number, such as *555.
• For folders, specify the path, such as C:\myFolder\*. Note that using C:\myFolder will not

match files in the myFolder directory, you have to specify an asterisk at the end.
• For web service input, specify any string. This string must match the optional Address parameter

of the Import web service call. Refer to Kofax Import Connector Developer's Guide.

Tip The difference between the filter options Recipient list and Address is subtle but potentially
important. For example, Adam sends an email to Bob, CC Cindy. Cindy has email forwarding
enabled, sending all mail to the SMTP server of Kofax Import Connector (for example,
invoice@KIC.com). In this case, you can use Bob's (or Cindy's) address as Recipient list filter.
However, only the address invoice@KIC.com can be used for the Address filter. Or another
example: Deborah’s POP3 mailbox (Deborah@example.com) has an additional address alias
(DeborahBusiness@example.com). Deborah can use the Recipient list field to filter her private and
business mail.

6. In the Destination field, select the destination that should be used for the documents matching the
specified criteria.

Note If you select a destination with an XML/EDI type, the XML/EDI type becomes an additional
filter criterion. I.e., if the document is not an XML file or the namespace/root element don't match,
the rule does not apply.

7. In the Subject field, type the subject of the received message. You can use the asterisk wildcard * to
specify all subjects. The wildcard is supported at the beginning or at the end of the string.

8. In the Originator field, type the email address of the sender of the message. You can use the
asterisk wildcard * to specify all addresses. The wildcard is supported at the beginning or at the end
of the string.

9. Click OK to save changes.
10. Optionally, select a rule and click Move Rule Up or Move Rule Down on the Connection Tasks

menu to establish rules priority. The following applies to rules priority:
• Rules higher on the list take precedence over lower rules; first matching rule wins.
• If none of the filter criteria match, the default destination is used.

11. Optionally, select a rule and click Remove Rule on the Connection Tasks menu to delete it.
12. Restart the KC Plug-In service to apply the configuration changes.
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Configure behavior when message import to Kofax Capture fails
1. Start Message Connector Configuration utility from the Kofax Import Connector group in the

Windows Start menu.
2. Go to the General tab.
3. If you want to forward messages that could not be imported to Kofax Capture to an operator, enter

the email address in the field Operator Email. In the Email From field, enter the email address that
should be used as the originator of the forwarded messages.

4. Select Keep Failed if you want to prevent deletion of messages that neither have been imported into
Kofax Capture nor forwarded to an operator. These messages will remain in Message Connector
storage until you manage them manually. This setting can cause the storage to run out of disk space
—at that point, all importing into Kofax Capture stops! Refer to Manage failed messages manually for
recommended handling.

5. In the Storage Size field, enter the size of the Message Connector storage database. Decreasing
the value below the default 100 MB is not recommended. Consider increasing the value, especially if
you have not configured the Operator Email and you selected to Keep Failed messages. Maximum
storage size is 64000 MB. Excessively large and full storage might require several minutes to
initialize. The minimum recommended value is the total size of documents received within 30
minutes during peak hours; preferably more.

6. If you configured an Operator Email, you need to update the values in the Email Outbound tab.
Your email server administrator should be able to provide the necessary information.

7. Click Save. Click Exit and restart service.

Configure different notification addresses for different accounts - scenario
There are scenarios when notifications of messages sent from a specific email address are required to be
sent to a particular email address. To achieve this functionality, perform the following configuration:

1. Create a new destination (this is a copy of the existing destination used for importing the emails).
2. Create a separate rule for this destination. Specify the sender's email address in Originator field.

See Configure rules.
3. Now, add the desired email addresses for sending the notification in the Send message to field of

the Destination configuration window. Sending Email Notifications.
4. Repeat steps 1 to 3 for adding additional notification email addresses for specific email accounts.

Configure KC Plug-In web service interface
Use this window to specify details about KC Plug-In web services connection. This web services
connection is used in two applications:
• Kofax Monitor uses it to monitor KC Plug-In. Refer to Use Kofax Monitor.
• Message Connector may use it internally to retrieve information from Kofax Capture.
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For details about the web service functions, refer to Kofax Import Connector Developers Guide.
1. Start KC Plug-In configuration. Do one of the following

• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic
Documents group in the Windows Start menu.

• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic
Documents > Configuration.

2. On the Assistance Tasks menu, click Web Services Configuration.
3. In the Port Number field, type the port number of the web services interface of KC Plug-In.
4. Select Use SSL if you want to use SSL for connecting to the web services interface of KC Plug-In.
5. In the Thumbprint field, copy the thumbprint of your SSL certificate. Refer to Installing certificate.
6. Click OK to save changes.
7. Restart the KC Plug-In service to apply the configuration changes.
8. Optionally, if you want to use the web service functions GetContentTypeList and

GetContentTypeDescription from external applications to retrieve batch class information from Kofax
Capture, Message Connector must be properly configured. Refer to Configure Message Connector
for web service input.

Installing certificate
1. Obtain a server certificate from a certification authority. The subject of this certificate must be the

name of the computer hosting KC Plug-In. Use the real name of the server, do not use localhost.
2. You also need certificate issuer's root certificate.
3. Start Certificates MMC Snap-In for computer account:

a. Start MMC, e.g. by running mmc.exe from the Start menu.

b. On the File menu, select Add/Remove Snap-In.

c. Click Add and select Certificates. Click Add again.

d. Select "Computer account". Click Next.

e. Select "Local computer". Click Finish.

f. Click Close, then click OK.
4. Use the snap-in to install the root certificate of the certification authority as a trusted root certification

authority:

a. Expand Console Root > Certificates (Local Computer) > Trusted Root Certification
Authorities > Certificates.

b. Right-click Certificates and select All Tasks > Import  from the context menu. The Certificate
Import Wizard starts.

c. Import issuer's root certificate (only if it is not yet part of the list).
5. Use the snap-in to install the server certificate:

a. Expand Console Root > Certificates (Local Computer) > Personal > Certificates.

b. Right-click Certificates and select All Tasks > Import  from the context menu. The Certificate
Import Wizard starts.

c. Import the server certificate.

36



Kofax Import Connector Administrator's Guide

6. Double-click the server certificate.
7. Go to the Details tab.
8. Scroll down and select the Thumbprint field. You can now copy the thumbprint to the KC Plug-In web

services configuration.

Configure SSL connection
Kofax Import Connector can be configured to operate in a secure environment, using SSL connections.

1. Create a SSL certificate for each Kofax Import Connector component that you want to connect
securely. You can use e.g. the following tools:
• Microsoft Active Directory Certificate Services
• OpenSSL

2. Configure each Kofax Import Connector component that you want to connect securely.
• For Message Connector, you need to convert the certificate to .pem format so that you can copy

the private key and the certificate to the configuration utility.
• For KC Plug-In, you must install the certificate via MMC (local account) and copy the thumbprint to

the configuration utility.
3. Install the certificates on all computers that connect to a secure server.

See also two example procedures in section Certificates.

Securing Connection Between Message Connector and KC Plug-In
1. In Message Connector configuration, click Advanced to display additional configuration options.
2. Open HTTP tab, select SslActive to enable SSL, or clear the check box to disable SSL.
3. If SSL is enabled: In Message Connector configuration, SSL Certificate tab, edit the fields as

necessary. Message Connector comes with a test certificate; you might wish to update it for
production use.

4. In KC Plug-In configuration, edit the connection to a Message Connector. In the Server URL field,
use the prefix “http” for a non-secure connection or “https” for a secure connection.

5. Click Test connection to verify the connection.

Securing Connection for Incoming SMTP Mail
1. In Message Connector configuration, Email Inbound via SMTP tab, SSL Active field, select

ONREQUEST or ALWAYS.
2. In Message Connector configuration, SSL Certificate tab, edit the fields as necessary.

Securing Connection for Outgoing SMTP Mail
In Message Connector configuration, Outbound Email tab, SSL Active field, select ONDEMAND or
ALWAYS.

Securing Connection for POP3/IMAP Mail
1. In KC Plug-In configuration, edit the connection to a Message Connector.
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2. Select the POP3/IMAP mail box and then click Edit.
3. In the SSL field, select Always or Negotiate.

Securing Connection for Exchange Web Services
1. In KC Plug-In configuration, edit the connection to a Message Connector.
2. Select the POP3/IMAP mail box and then click Edit.
3. The prefix of the EWS URL in the Host field determines whether the connection is secure. Use https

for secure connections.

Configure Kofax Capture integration
Use this window to specify details about how Kofax Capture and Kofax Import Connector interact.

1. Start KC Plug-In configuration. Do one of the following
• On a Kofax Capture Network Server remote site, start KC Plug-In from the KIC - Electronic

Documents group in the Windows Start menu.
• On other Kofax Capture installations, start Kofax Capture Administration and select Electronic

Documents > Configuration.
2. On the Assistance Tasks menu, click General Settings.
3. If you are using the User Profiles feature of Kofax Capture, specify the parameters User ID and

Password. Click Test credentials to verify that you can correctly connect.
4. If you want to keep Kofax Import Connector connected to Kofax Capture and log off only on service

shutdown, select Cache import process instance. Selecting this option improves performance. If
not selected, Kofax Import Connector will log on to Kofax Capture each time a batch is imported, and
it will log off afterwards.

5. The parameter "Import pool size" is deprecated. Use the default value (1). To improve
performance, use the parameter "Number of KIC process instances" instead.

6. If you want to improve performance of KC Plug-In by running multiple instances of the process
(vertical scaling), you can increase the value of the parameter "Number of KIC process
instances". The extra instances may fail to start if not enough hardware resources are available.

Note With multiple processes running in parallel, your batch structure might change. E.g., if
a customer always copies a group of 5 documents to the import folder, has a batch size of 5
configured, and expects to see the group in one batch, this will not work. The documents will be
split among processes and each creates its own batch. In such cases where batch structure should
be constant, trigger files should be used in conjunction with vertical scaling. This will ensure that
only one KC Plug-In process can access the imported content at any given time.

7. If you want to use UTC time for all imported documents, select Use UTC time. When not selected,
the local time of Kofax Capture is used.

8. KC Plug-In records all the events/actions in log files. If you want to use a custom location for creating
log files, select a path in Log files path. If you do not specify any custom location, log files are
created at the default location.

9. KC Plug-In provides two types of log levels: INFO and DEBUG. INFO level logs general information
about each event/action. This level is best suited for production environment. DEBUG level logs
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detailed information about each event/action. This level is used for debugging or identifying any
issues. Select the desired logging preference in the Log level list. Default log level is INFO.

Note Use a local system path for saving log files. Network shared directories are not supported.

10. Click OK to save changes.
11. Restart the KC Plug-In service to apply the configuration changes.

Configure Kofax Converter
Configure the advanced settings of the Kofax Converter (KfxConverter) by editing the KFXConverter.ini
file in a text editor. This ini file is located in the same folder as the Kofax Converter executable. The default
location is:

C:\Program Files (x86)\Kofax\KIC-ED\MC\bin\KFXConverter\.

Message Connector installs the file KFXConverter_Default.ini to the same folder. If the KFXConverter.ini
file does not exist when Message Connector starts, a copy of KFXConverter_Default.ini is created. On
upgrade, an existing KFXConverter.ini is not modified by setup.

The following parameters are available:

Note Fix the line breaks if you copy and paste the code from this guide.

Group Parameter name Default
Value

Description

EnableMargin False KfxConverter will consider the margin parameters
and the parameter PgNmDistFromHeader only if this
value is set to true.

LeftMargin 3.175 cm Left margin of page (in centimeters).

RightMargin 3.175 cm Right margin of page (in centimeters).

TopMargin 2.54 cm Top margin of page (in centimeters).

BottomMargin 2.54 cm Bottom margin of page (in centimeters).

PgNmDistFromHeader 1.3 cm Page number distance from header (in centimeters).

EnableFontSize False KfxConverter will consider "FontSize" parameter only
if this value is set to true.

Note If this parameter is set to true, all the text in
the converted PDF file will be of same font size.

EML2PDF

FontSize 12 Font size in points.
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Group Parameter name Default
Value

Description

DateFormat Defines the date format. If empty, the default date
format is used. Examples:
• DateFormat="dd-MMM-yy"

• DateFormat="yyyy-MM-dd"

For more information, see http://msdn.microsoft.com/
en-us/library/8kb3ddd4(v=vs.110).aspx

Note Depending on the regional settings of
your operating system, certain separators are
not available. For example, a forward slash
configured in the ini file might be replaced with a
hyphen as date separator.

FitTableWidthToPage True Resize the table width in an output PDF file when
converting EML files (including body with message
header).
If set to true, KFXConverter sets the table width
based on the page size in output PDF files.

ResizeLargeImages 2 Resize the images that are larger in size.
The following options are available:
0 - Image is not resized.
1 - The image size is compared with the section size
of the document. If the image size is larger than the
section size, image is resized to fit the section.
2 - Free space is calculated based on whether an
image is inline or floating. The image resize ratio to fit
the page size is calculated as per the longer side of
the image, and then the image is resized.

Note When the input file contains large size
images and if ResizeLargeImages is set to 0, file
conversion may result in data loss.

PDF2PDF ALCWebServiceTimeout 1200 sec Adobe Experience Manager web service timeout in
seconds

TEXT2PDF FontType Arial
Unicode MS

Specify the font type for the generated PDF. The
font must be installed on the computer on which
KFXConverter is used.

FitAllColumnsToOnePage True All the columns are set to one page if this value is set
to true

PaperOrientation -1 Defines the paper orientation.
Default is -1, for Landscape 0, for Portrait 1

EXCEL2PDF

PaperSize Default If set to default, this will disable the papersize setting.
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Group Parameter name Default
Value

Description

ConvertSheets All KFXConverter will convert the pages according to
the values specified in field. Possible values are All,
Active, 1, 2, 3 etc. Specify the values as comma
separated values.
For example:
ConvertSheets=Active,1

This is will convert the first page and the active page.
ConvertSheets=All

This is will convert all the pages.

Note If a blank page is selected for conversion
and no printable area is selected in excel, this
page will be ignored at the time of conversion.
But, if a blank page with defined printable area
is selected for conversion, KFXConverter will
convert this page into pdf.

EnableMargin False KFXConverter will consider the margin parameters
only if this value is set to true.

LeftMargin 1 Left margin of page (in centimeters).

RightMargin 1 Right margin of page (in centimeters).

TopMargin 1 Top margin of page (in centimeters).

BottomMargin 1 Bottom margin of page (in centimeters).

EnableMargin False KFXConverter will consider the margin parameters
only if this value is set to true.

LeftMargin 0.3528 cm Left margin of page (in centimeters).

RightMargin 0.3528 cm Right margin of page (in centimeters).

TopMargin 2.54 cm Top margin of page (in centimeters).

BottomMargin 2.54 cm Bottom margin of page (in centimeters).

HTML2PDF

ResizeLargeImages 2 Resize the images that are larger in size.
The following options are available:
0 - Image is not resized.
1 - The image size is compared with the section size
of the document. If the image size is larger than the
section size, image is resized to fit the section.
2 - Free space is calculated based on whether an
image is inline or floating. The image resize ratio to fit
the page size is calculated as per the longer side of
the image, and then the image is resized.

Note When the input file contains large size
images and if ResizeLargeImages is set to 0, file
conversion may result in data loss.
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Group Parameter name Default
Value

Description

FixedColumnWidths False Resizes the table column width in the output PDF file
as per the content in the input HTML file tables.

Note When column width in an input file table
is large, file conversion may result in data loss.
To prevent data loss, set FixedColumnWidths to
true.

EnableMargin False KFXConverter will consider the margin parameters
only if this value is set to true.

LeftMargin 3.175 cm Left margin of page (in centimeters).

RightMargin 3.175 cm Right margin of page (in centimeters).

TopMargin 2.54 cm Top margin of page (in centimeters).

MHT2PDF

BottomMargin 2.54 cm Bottom margin of page (in centimeters).

EXTERNAL
RESOURCE
LOADING

LoadExternalResources True True or False. If set to False, when converting
EML or MSG documents, KFXConverter does
not download any externally linked resource. For
example, if LoadExternalResources = false,
KFXConverter will not download an image from an
internet hyperlink.

OriginalDocumentFolder If document conversion is failed and path is valid,
original file is saved at this path.

EnablePageHeader True If EnablePageHeader=false, it will disable the
page number displayed on top of each page.

EncodingType UTF-8 If encoding type is defined in the input
files, KFXConverter uses the same for
converting the documents; otherwise, the default
encoding type or the value specified for the
EncodingType parameter is used.
The encoding type is only applicable for HTML, MHT
and EML file formats.

GENERAL

EnableAttachmentList True If set to False, KFXConverter removes the
attachment list from the header of the converted file.
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Group Parameter name Default
Value

Description

PDF2PDFA AllowedErrors 0 If Standard is selected in PDF to PDF/A conversion
engine in Message Connector, then KFXConverter
allows the document conversion with the specific
conversion errors. To allow one or more conversion
errors at the time of conversion, set the value of
AllowedErrors to one error code or a combination
of error codes. If AllowedErrors=0, no error
is allowed at the time of document conversion.
See Handle PDF/A normalization errors using
AllowedErrors parameter.
All the error codes and all possible values generating
from an OR operation of the following error codes
can be used to ignore one or more document
conversion errors.

Error code Description

4 Allows visual differences in output file

8 Allows resolving name collisions of
colorants (PDF/A-2 and PDF/A-3
only)

16 Allows removing optional content
groups (layers). For PDF/A-1 only.

32 Allows removing transparency. For
PDF/A-1 only.

64 Allows removing embedded files

128 Allows removing non-convertible
XMP metadata

512 Allows removing all signatures while
normalizing the signed document.
The conversion of a file to PDF/A
invalidates all signatures of the input
file.

4096 Allows normalizing corrupt input
document

16384 Allows substituting similar font when
the same font is not available for
embedding.

32768 Allows removing interactive elements
such as actions or annotations

For example,
• If AllowedErrors=4, the visual differences in

output file does not cause a document conversion
error.

• If AllowedErrors=132, that is, combination of
error code 4 and error code128, the conversion
is done even if there are visual differences in the
output file or non-convertible XMP metadata is
removed.
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Group Parameter name Default
Value

Description

TryFlattenXFA TryFlatteningXFAWith
outALC

False If set to true, enables flattening of XFA forms when
Adobe Experience Manager is not available. Make
sure the Legacy option is selected in the PDF
to PDF/A conversion engine field in Message
Connector.

Note Kofax recommends that you use Adobe
Experience Manager for flattening of XFA
forms; use of any other tool may result in an
unpredictable output.

Handle PDF/A normalization errors using AllowedErrors parameter
Certain actions may alter the visual appearance of the file or remove crucial data at the time of
conversion. You must identify conversion errors that are tolerable and can be allowed, and the ones which
are critical and should not be allowed.

To not include errors that are critical for your processing, set the value of AllowedErrors parameter
appropriately.

You can do the following to minimize the document conversion errors:
• Convert input documents to PDF/A-2 instead of PDF/A-1. As PDF/A-2 allows some features of newer

versions of the PDF reference such as transparency, optional content (layers), or embedded files.
• If fonts were substituted for earlier processing, install the missing fonts.
• For documents with non-convertible XMP Metadata, update the PDF creating software to generate valid

XMP metadata.

Enable SecurityBoost
SecurityBoost is a feature that improves the safety of the connection between the Kofax Capture server
and workstation.

1. Enable SecurityBoost in Kofax Capture. Refer to Kofax Capture documentation for details.
2. Set a log on user account for the KC Plug-In service. This user must have read access to the

following folders:
• \\%SERVER%\capturesv\config

• \\%SERVER%\capturesv\BatchDb (and subfolders)
• \\%SERVER%\capturesv\PubTypes (and subfolders)

3. If the Save to Disk option in KC Plug-In configuration is selected, write access is also necessary to
the following folder: \\%SERVER%\capturesv\images.

4. The user to be used with the SecurityBoost option requires the "Local Launch" and "Local Activation"
COM permission. COM permissions can be modified with Control Panel > Administrative Tools >
Component Services. Select COM Security tab in properties of Console Root\Component Services
\Computers\My Computer. Click Edit Default under Launch and Activation Permissions. Select the
user and modify the permissions.

44



Kofax Import Connector Administrator's Guide

5. The user requires Full Control access to the following registry key: HKEY_LOCAL_MACHINE
\SOFTWARE\Kofax\KIC-ED\KCPlugIn

6. If you want to use KC Plug-In web service interface (Configure KC Plug-In web service interface),
additional steps are necessary:
• Reserve the namespace http://+:<port>/KIC-Electronic-Documents
• Reserve the namespace https://+:<port>/KIC-Electronic-Documents and register the thumbprint of

the certificate for the IP address:port (if you want to use SSL)

For example, on Windows Server 2003, use the command httpcfg:
• Namespace reservation syntax:

httpcfg set urlacl u/ URL /a ACL

The /u parameter takes a string containing a fully qualified URL that identifies the reservation.
The /a parameter takes a string containing an Access Control List in the form of a Security
Descriptor Definition Language (SDDL) string.
• Namespace reservation for port 8001

httpcfg set urlacl /u http://+:8001/KIC-Electronic-Documents /a D:(A;;GX;;;WD)

• Namespace reservation for port 8002 (SSL):
httpcfg set urlacl /u https://+:8002/KIC-Electronic-Documents /a D:
(A;;GX;;;WD)

• SSL thumbprint registration syntax:
httpcfg set ssl /i Ip:Port /h SSL_Hash /g "{GUID}"

The /i parameter takes a string that specifies the IP Address:port combination. The /h parameter
takes a string of hexadecimal digits specifying the thumbprint hash of the certificate being added.
The /g parameter takes a string representing a Globally Unique Identifier (GUID) that identifies the
application that added the certificate.
• SSL thumbprint registration:

httpcfg set ssl /i 0.0.0.0:8002 /h a9f05807bb757c41ba2e1c457ac2a78f00395a69 /
g"{4f38c942-c7e7-421b-bcec-bd3290c3b921}"

The IP address 0.0.0.0 matches every IP address on the local computer.

On Windows Server 2008 or Windows 7, use the command netsh:
• Namespace reservation syntax:

Netsh http add urlacl  url=URL user= User

The url parameter specifies the fully qualified Uniform Resource Locator (URL). The user
parameter specifies the user or user-group name.
• For port 8001:

netsh http add urlacl url=http://+:8001/KIC-Electronic-Documents/ user=
\EVERYONE

• For port 8002 if SSL is enabled:
netsh http add urlacl url=https://+:8002/KIC-Electronic-Documents/ user=
\EVERYONE

• SSL thumbprint registration syntax:
netsh http add sslcert ipport= IPAddress:port certhash=CertHash appid=GUID

The ipport parameter specifies the IP address and port for the binding. A colon character (:)
is used as a delimiter between the IP address and the port number. The certhash parameter
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specifies the SHA hash of the certificate. This hash is 20 bytes long and is specified as a
hexadecimal string. The appid parameter specifies the GUID to identify the owning application.
• For port 8002:

netsh http add sslcert ipport=0.0.0.0:8002
 certhash=a9f05807bb757c41ba2e1c457ac2a78f00395a69 appid={4f38c942-c7e7-421b-
bcec-bd3290c3b921}

If SecurityBoost is not enabled, the folder access permissions should be set according to the Kofax
Capture documentation.

Message fields
Message fields are metadata related to a document such as message subject. These values can be
mapped to Kofax Capture batch/folder/document fields.

If a message field is mapped to a Kofax Capture field, it will be automatically populated with the proper
value during importing to Kofax Capture.

The message fields mapping can be configured in KC Plug-In, for each destination. See Configure
destinations for imported documents.

Message field Description

KfxMessageAttachmentList The file names of the converted documents or attachments.
For Folder import, this returns the file names of all the
converted documents in the folder delimited by ';'. For email
import, this returns the file names of the converted attachments
of a message delimited by ';'.

KfxMessageCorrelation The correlation information of the message (for internal use).

KfxMessageDeliveryPriority The priority of the message. Reserved for future use. Currently
static value 1.

KfxMessageDeliverySuspectedDupli Reserved for future use. Currently static value 0.

KfxMessageDeliveryType The type of delivery of the message. Reserved for future use.
Currently static string TO.

KfxMessageFileName The file name of the document. For fax server import, this
returns the server internal file name of the fax message. This
does not return anything for EMAIL and Folder import.

KfxMessageID The unique ID of the message given by the Message
Connector on message arrival.

KfxMessageOwnerReference For email documents: mime-header/message-id
For faxes: server-specific message ID

KfxMessagePages The number of fax pages in the message.

KfxMessageReceptionCallerId The number of the sending fax machine. (Optionally available
for FoIP, Biscom, KCS)

KfxMessageReceptionErrorImporting Contains the error message if the message is rejected by
Kofax Import Connector.
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Message field Description

KfxMessageReceptionErrorInfo Provides an additional description if
KfxMessageReceptionErrorLevel is non-zero. For messages
from KCS, this field contains the KCS error code.

KfxMessageReceptionErrorLevel Describes the error level of the received document using the
following values: 0 = OK, 1 = partially OK or incomplete, 2 =
failed

KfxMessageReceptionTimeCreated For emails, this is the time when the Message Connector
retrieved the message.
For faxes, this is the time when the message was received by
the fax server.

KfxMessageSubject The subject of the message. For faxes, this is "Fax from" + TSI.

KfxMessageTimePosted Only available for email messages, this field contains the date
and time when the message was sent.

KfxMessageNumberOfPagesImportedForBatch The number of pages in the files imported from a folder. The
number of pages is calculated using the following rules:
• Each image file is split into pages, and each individual page

is counted as one page.
• Each non-image document (including PDF files) imported as

an eDocument file is counted as one page.
• Each PDF file imported as a TIFF file is split into pages, and

each individual page is counted as one page.

KfxMessageNumberOfRemovedBlankPages The number of blank pages removed from the documents at
the time of VRS processing.

KfxOriginalRecipients Contains a list of the original recipients as specified by the
message originator. For KCS, it contains the original number
before forwarding by event. For mailbox emails, it contains the
To/Cc recipients.

KfxOriginatorName The full name of the message originator. For faxes, this is the
TSI. For SMTP/POP3/EWS, it’s the originator display name
(mime-header/from/mailbox/displayname).

KfxOriginatorNumber The fax number of the originator (caller ID) or originator email
(mime-header/from/mailbox/address) for POP3/SMTP/EWS
mail.

KfxOriginatorService The service name of the originator. In case of fax FAX and in
case of email EMAIL.

KfxRecipientName The full name of the message recipient. For POP3, this is the
mailbox display name.

KfxRecipientNumber The recipient fax number (called party number) or email
address (for SMTP it’s the first active email recipient, for POP3
the mailbox user name).

KfxRecipientsTo Comma separated list of To recipients.

KfxRecipientsCc Comma separated list of Cc recipients.

KfxRecipientsBcc Comma separated list of Bcc recipients.
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Message field Description

KfxRecipientService The service name of the recipient. In case of fax FAX and in
case of email EMAIL.

KfxRoutingNumber The meaning of this message field is different for various inputs
• FAX: Extension (called-party-number)
• SMTP: active email recipient
• POP3/IMAP/EWS: mailbox user name
• FOLDER: full path of the imported file
• WEBSERVICE: empty string

KfxMessageReceptionTimeReceived The reception time of fax.

KfxImportFolderName Folder name of the sub folder from which messages are polled.
Example, if the polling folder is "Inbox" and sub folder is "sub1",
then the field will contain "Inbox/sub1".

KfxInputSourceName The type of input source. For email, it is POP3, IMAP, SMTP, or
EWS. For fax, it is BISCOM, RightFax or KCS. For file import, it
is folder.

The message extension fields are reserved for future versions.

Document metadata are also available in Kofax Capture as custom storage strings (for documents and
folders) with the prefix ED_CSS_. Custom storage strings can be read via the Kofax Capture API and
could be used for example in an export connector or in custom scripts. Please refer to Kofax Import
Connector Developers Guide for more information about custom storage strings.

Set Windows permissions for Message Connector
This section describes the permissions in Windows that are required to run Message Connector.

Note the following:
• The user who performs the installation must be a member of the local Administrator's group
• The MS Office document conversion can be configured to run as:

• The interactive user (a user must be logged on the computer)
• A user specified in the Message Connector document conversion configuration

DCOM Permission
1. Open Window's Component Services by using the following command in Command Prompt: C:

\WINDOWS\SysWOW64\comexp.msc.
2. Expand Component Service > Computers.
3. Right click on My Computer and select Properties. From the My Computer Properties window,

select the COM Security tab.
4. For AccessPermissions, click the Edit Defaults button and add a user with full permissions.
5. For Launch and Activation Permissions, click the Edit Defaults button and add a user with full

permissions.

48



Kofax Import Connector Administrator's Guide

6. Click OK.

Folder Permissions
The following table lists the necessary folder permissions to run Message Connector.

Folder Permission

ProgramData\Kofax\KIC-ED\MC Full Control

Installation folder

Note Folder where Message Connector is installed.

Read

Temp folder (generally, Windows\Temp)

Note You can modify this folder from Windows
environment variables.

Full Control

Registry Permissions
For running Message Connector on Windows Server 2008 R2

The following table lists the necessary registry key permissions to run Message Connector.

Registry Key Permission

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Kofax\KIC-ED\MC Read

HKEY_CLASSES_ROOT\.png Full Control

HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion
\Windows

Full Control

HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion
\Devices

Full Control

For document conversion using MS Office on Windows Server 2008 R2

The following table lists the necessary registry key permissions for document conversion in Message
Connector using MS Office on Windows Server 2008 R2.

Registry Key Permission

HKEY_CLASSES_ROOT\AppID\{00020906-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\AppID\{00020812-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\AppID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

HKEY_CLASSES_ROOT\CLSID\{00020812-0000-0000-
C000-000000000046}

Full Control
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Registry Key Permission

HKEY_CLASSES_ROOT\CLSID
\{91493441-5A91-11CF-8700-00AA0060263B}

Full Control

HKEY_CLASSES_ROOT\CLSID\{00020906-0000-0000-
C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes\Wow6432Node\CLSID
\{00020906-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{000209FE-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{000209FF-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{00020812-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{00024500-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\CLSID
\{91493441-5A91-11CF-8700-00AA0060263B}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\AppID
\{00020906-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\AppID
\{00020812-0000-0000-C000-000000000046}

Full Control

HKEY_LOCAL_MACHINE\SOFTWARE\Classes \Wow6432Node\AppID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

For running Message Connector on Windows 7 64-Bit

The following table lists the necessary registry key permissions for Windows 7 64-bit to run Message
Connector.

Registry Key Permission

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Kofax\KIC-ED\MC Read

HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion
\Windows

Full Control

HKEY_USERS\.DEFAULT\Software\Microsoft\Windows NT\CurrentVersion
\Devices

Full Control

For document conversion using MS Office on Windows7 64-Bit

The following table lists the necessary registry key permissions for document conversion in Message
Connector using MS Office on Windows Server 7 64-bit.

Registry Key Permission

HKEY_CLASSES_ROOT\AppID\{00020906-0000-0000-
C000-000000000046}

Full Control
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Registry Key Permission

HKEY_CLASSES_ROOT\AppID\{00020812-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\AppID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

HKEY_CLASSES_ROOT\CLSID\{00020812-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\CLSID
\{91493441-5A91-11CF-8700-00AA0060263B}

Full Control

HKEY_CLASSES_ROOT\CLSID\{00020906-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{00020906-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{000209FE-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{000209FF-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{00020812-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{00024500-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\CLSID
\{91493441-5A91-11CF-8700-00AA0060263B}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\AppID\{00020906-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\AppID\{00020812-0000-0000-
C000-000000000046}

Full Control

HKEY_CLASSES_ROOT\Wow6432Node\AppID
\{048EB43E-2059-422F-95E0-557DA96038AF}

Full Control

Set Windows permissions for KC Plugin
This section describes the permissions in Windows that are required to run KC Plugin.

DCOM Permission (Standalone and Client/Server)
1. Open Window's Component Services by using the following command in Command Prompt: C:

\WINDOWS\SysWOW64\comexp.msc.
2. Expand Component Service > Computers > My Computer > DCOM Config.
3. Right click on {A6063718-7889-46E0-AC60-5A7C958710DC} and select Properties. From the

Properties window, select the Security tab.
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4. For Launch and Activation Permissions, select the Customize option and click the Edit… button.
Add a user with full permissions.

5. For Access Persmissions, select the Customize option and click the Edit… button. Add a user with
full permissions.

6. For Configuration Permissions, select the Customize option and click the Edit… button. Add a
user with full permissions.

7. Click OK.

Note If "Shared Profiles" are enabled in Kofax Capture, assign full permissions to SharedProfileData in
DCOM Config.

Folder Permissions for Standalone KC Plugin
The following table lists the necessary folder permissions to run KC Plugin.

Folder Permission

ProgramData\Kofax\Capture Read and Execute

ProgramData\Kofax\Capture\Local\BatchDB Full Control

ProgramData\Kofax\Capture\BatchDB Full Control

ProgramData\Kofax\KIC-ED\KCPlugIn Full Control

ProgramData\Kofax\Capture\Images Full Control

Installation folder Full Control

Temp folder (generally, Windows\Temp) Full Control

Folder Permissions for Client/Server Mode (Windows 2008 R2)
The following table lists the necessary folder permissions for Windows Server 2008 R2 to run KC Plugin in
Client/Server installation.

Folder Permission

ProgramData\Kofax\CaptureSV Read and Execute

ProgramData\Kofax\CaptureSV \BatchDB Full Control

ProgramData\Kofax\CaptureSV\Images Full Control

ProgramData\Kofax\KIC-ED\KCPlugIn Full Control

Installation folder Full Control

Temp folder (generally, Windows\Temp) Full Control

Note the following:

User should have full access to the following folders which are configured in batch class setting.
• Image folder which is specified in batch class properties
• Default storage folder which is specified in export connector
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Registry Permissions
The following table lists the necessary registry key permissions to run both standalone and client/server
installation of KC Plugin.

Folder Permission

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
\Kofax\KIC-ED\KCPlugIn

Read

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
\Kofax Image Products

Read

All file type extensions in HKEY_CLASSES_ROOT
For example, HKEY_CLASSES_ROOT\.doc
HKEY_CLASSES_ROOT\.png

Read
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Features and integration examples

This section provides examples on how to integrate Kofax Import Connector with third party software and
hardware and describes some advanced features of the product.

Connect to Biscom fax server
In addition to configuring the connection to the Biscom fax server in KC Plug-In, Biscom client software
must be installed and a user/extension should be identified on the fax server for use with Kofax Import
Connector. Work with your fax server administrator to complete the following steps.

Configure Biscom server
1. On the Biscom fax server, start the FAXCOM Administrator tool.
2. Create (or reserve) a user/extension for use with Kofax Import Connector.
3. Enable the network share connection to the Biscom server and note the service path.
4. Close the tool.

Install FAXCOM Client
1. On the Message Connector computer(s), install the Biscom client software, the FAXCOM Client.
2. If the computer where the FAXCOM Client is installed belongs to a Windows domain, run this

command (only necessary when the domain user lacks access rights to the Biscom share):
Net Use <Biscom_service_path> /USER:<Biscom_user> <password>

3. Start the FAXCOM Client from the FAXCOM group of the Windows Start menu.
4. Type the login information and click OK. You must be able to connect.

On successful login, the FAXCOM Client window is displayed.
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5. Close the client.

Connect to RightFax fax server
In addition to configuring the connection to the RightFax fax server in KC Plug-In, RightFax client software
must be installed and a user/extension should be identified on the fax server for use with Kofax Import
Connector. Work with your fax server administrator to complete the following steps.

Configure RightFax server
1. On the RightFax fax server, start the Enterprise Fax Manager tool.
2. Create (or reserve) a user/extension for use with Kofax Import Connector.
3. Close the tool.

Install RightFax client
1. On the Message Connector computer(s), start the RightFax Product Suite setup.
2. When prompted for setup type, select Typical Client.
3. In the RightFax Server Name field, type IP address or name of the fax server.
4. Click Install and finish the installation.
5. Start RightFax FaxUtil from the Windows Start menu.
6. Type the login information. Do not select Remember password! Click OK. You must be able to

connect.
On successful login, the RightFax FaxUtil window is displayed.
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7. Close the client.

Forwarding Faxes from Multiple Mailboxes to a Single Queue User
In KC Plug-In, you can only configure a single user for accessing RightFax. If you need to access multiple
mailboxes, this would have to be the administrator user. As a workaround, if you don't want to use
administrator user for security reasons, consider setting up fax forwarding to a dedicated user, and use
the credentials of this dedicated user in KC Plug-In. Each fax user must configure fax forwarding using
RightFax FaxUtil.

1. Start RightFax FaxUtil from the Windows Start menu and log in.
2. On the Tools menu, click Options.
3. On the Receiving tab, select Forward Received Faxes to User.
4. Select the dedicated user as the recipient of the forwarded faxes.
5. Confirm the changes and close FaxUtil.

Keeping Messages on RightFax Server
By default, Kofax Import Connector deletes imported messages from the fax server. You can configure
Message Connector to keep the messages on the fax server for later processing.

1. Open the file SolutionConfig.xml from the folder MC\config in an editor.
2. Add the following content between the lines </SSL> and <CallPeerList>:

<FaxServer>
  <RFaxKeepMsgs>2</RFaxKeepMsgs>
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</FaxServer>

3. Save the file and close it.
Message Connector configuration now contains a new tab Fax Server with a single parameter
"Keep messages on RightFax Server" set to "[2] yes".

4. Start Message Connector configuration. Verify the value in the Fax Server tab.
5. Click Save, then click Exit.

Imported messages are no longer deleted from the RightFax server, instead, the text "KCFax:marked to
delete" is added to the comment field and the flag FAXFLAG_GENERIC2 is set.

Connect to Kofax Communication Server
In addition to configuring the connection to the Kofax Communication Server in KC Plug-In, a user/
extension should be identified on the fax server for use with Kofax Import Connector. Work with your fax
server administrator to complete the following steps.

1. On the Kofax Communication Server, start the TCfW Communication Server Client.
2. Create (or reserve) a user/extension for use with Kofax Import Connector.
3. Optionally, if you want to import faxes received by multiple KCS users, set up fax forwarding for each

of the user; and forward the faxes to the user created in step 2.
4. Close the client.

Handle of multipage TIF Files
Kofax Capture Import Connector - Folder has the function to split incoming multipage TIF files into pages
before importing them to Kofax Capture. Kofax Import Connector uses a different approach and leverages
existing Kofax Capture batch class options to achieve similar results.

Note If you are using Kofax Capture Network Server, you can only to perform batch class configuration
on the central site.

1. Start Kofax Capture Administration from the Kofax Capture group in the Windows Start menu.
2. Select your batch class and edit its properties:

a. In the Separation and Form Identification tab, select Kofax fixed pages.

b. In the Advanced tab, edit the parameter Process documents as independent batches.
• Clear it if you want to treat each page of a multipage TIF as a separate document.
• Select it if you want to treat each page of a multipage TIF as a separate batch.

3. Select your form type and edit its properties:

a. Select Fixed number of pages.

b. Enter "1" in the field below.
4. Publish the batch class to make the changes effective.
5. In Kofax Capture Administration, on the menu, select Electronic Documents > Configuration.
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6. Select your destination and click Edit Destination.

a. Go to the Import Mappings tab.

b. In the Batch class field, select the batch class configured in step 2.

c. In the Document class field, select Loose Pages.

Note Kofax Import Connector checks only the form type option and no other internal form type
settings. Therefore, if page separation and fixed number of pages options are set in the form
type, these will be ignored. Kofax Import Connector only performs simple separation, that is:
• Create document per attachment
• Create document per message

7. Restart the KC Plug-In service to make the changes effective.

The behavior in Kofax Capture is almost identical to KCIC Folder behavior, only the batch names in Kofax
Capture Batch Manager are can be different.

As Kofax Import Connector combines multiple previous import connectors, TIF splitting in now available
to any input document. If you want to restrict this feature to documents imported from folder, create an
exclusive destination and set up an appropriate rule. Refer to Configure rules.

Split TIF files behave differently when archived. It is not possible to save each page to a separate folder.
The original, unsplit TIF file is archived instead.
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Import EDI files
Electronic Data Interchange (EDI) is a standard for exchanging data via electronic means. Kofax Import
Connector supports two prominent international EDI standards:
• UN/EDIFACT
• ANSI ASC X12

Basic workflow:

1. Customer copies the EDI files to a designated folder.

2. Kofax Import Connector ingests EDI documents via folder import.

3. Kofax Import Connector uses Rules to determine that raw EDI document belongs to a generic EDI
destination.

4. Kofax Import Connector converts the EDI data stream to XML.

5. Kofax Import Connector uses Rules, XML namespace, and root element on the transformed EDI
document to determine the proper destination (batch class).

6. Kofax Import Connector imports the XML into Kofax Capture. Depending on the destination setting,
XML data is mapped to Kofax Capture fields and/or rendered as PDF or TIF.

Note You can import EDI files from a folder. Other sources, such as email import or web service import,
are not supported.

Important configuration steps:
1. Create a generic destination for EDI. See Configure destinations for imported documents.

• On the Import settings tab, enter Name.
• On the Advanced Conversion and Import tab, select Enable EDI to XML conversion and

routing at this destination.

Most other destination settings are ignored. As soon as the raw EDI is converted to an XML
document, the XML is rerouted to a different destination.

2. Create a rule that routes your EDI files from a certain folder to the generic EDI destination. See
Configure rules.

3. For each EDI type you want to use, you need to provide XML schema definition file and a sample
XML file. See Configure EDI types.

4. Create a destination for each EDI type. Use XML mapping and rendering functions:
• Use XSL transformation to map metadata and XML data
• Render XML documents

Note If you want to import EDI documents as EML or MSG, you have to configure it in the generic,
routing destination. These settings are ignored for the EDI-specific destinations.

5. Create rules that route the XML documents to their Kofax Capture destinations. These specific rules
must be in a higher position in the list than the generic rule created in step 2. Click Move Rule Up or
Move Rule Down on the Connection Tasks menu to establish rules priority.
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Internally, the change to a different destination in the EDI feature is done using the script ReRoutingScript.
See the Kofax Import Connector Developer's Guide. The script tells KC Plug-In to assign the message
to a different destination. The script modifies the message in a way that it can be processed by the new
destination. KC Plug-In then processes the message with the new destination and uses the appropriate
XSL transformation and mapping. When message rendering is enabled in the new destination, the
conversion to TIFF and PDF configured for the original destination applies.

Note When you select to "Include original content", the EDI data stream is not available in the original
format, only converted as XML.

Use EDI samples
Four sample EDI formats are installed with KC Plug-In. They are available in the installation folder of KC
Plug-In.
• EDI\SampleConfigFiles\EDIFACT.D.2000A-INVOIC

• EDI\SampleConfigFiles\EDIFACT.D.2000A-ORDERS

• EDI\SampleConfigFiles\X12.5010-810

• EDI\SampleConfigFiles\X12.5010-850

Each sample folder contains an XSD and XML file for configuring the EDI type, a Kofax Capture batch
class, a XSL transformation file for generic mapping, and a sample input file.

1. Configure a new EDI type.

a. As your XML schema definition file (.xsd), select one of the following:
• INVOIC.xsd
• ORDERS.xsd
• 810.xsd
• 850.xsd

b. As your sample XML file, select Sample.xml from the same folder.
2. Import the sample batch class from the same folder to your Kofax Capture and publish it.
3. Create a new destination.

a. As XML type, select the one created in step 1.

b. As Batch class, select the one imported in step 2.

c. Select Generic XML mapping.

d. Click Show Files for Visual Designer to open the folder containing destination specific
configuration files.

e. Copy the file XMLMapping.xslt from the sample folder to the destination folder.

You can now use folder import to import the sample input file ("Input file <type>.txt") to test the
functionality.

Note The provided EDI samples function only with generic XML mapping.
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Image normalization
The following rules are used for handling the resolution and dimension. The first matching rule governs
the conversion:

1. If the resolution of an incoming image matches the requested resolution, the image is not changed.

2. If the value of parameter MaxPrintSize is set to a non zero value, resampling is skipped for files with
size more than MaxPrintSize. This parameter is available in the script file image2tif.bat in the folder
C:\Program Files (x86)\Kofax\KICED\MC\Scripts. By default, MaxPrintSize is set to 0.

3. If the x and y resolutions differ, the image is resampled to the requested resolution (non-quadratic
pixel case).

4. If the resolution value is wrong, it is set to the requested value without resampling the image. This will
change the printing size of the image. Such images are not resampled in order to avoid quality loss.
A resolution is wrong if one of the following conditions are true:
• The resolution is below the MindxResolution which is set to 96 dpi. (if the MindxResolution is not

set, ImageMagick returns 72 dpi)
• The resolution exceeds 200 dpi and the width is less than 1500 pixel (19.5cm@200dpi).
• The resolution exceeds 200 dpi and the height is less than 2000 pixel (25.4cm@200dpi).

5. If the resolution is higher than requested, the image is down-sampled to the requested resolution.

6. If none of the listed rules applies, the image conversion depends on the configuration in the script
file image2tif.bat in the folder C:\Program Files (x86)\Kofax\KIC-ED\MC\Scripts. Open
the file with a text editor and change the value in the line Set ResetResolution=0. The following
values are supported:
• 0: Resample image and change resolution. This is the default option, same behavior as in Kofax

Import Connector 1.0.0 and 2.0.0 or Kofax Capture Import Connector - Folder. Image file size is
increased without improving image quality. Resampling can be a time-consuming operation that
often results in lower performance.

• 1: Change the resolution without resampling. This reduces the print size of the image. This is the
same behavior as in Kofax Import Connector 2.1.0.

• 2: Image is not changed. Best performance.

PDF normalization
When you select to convert your message content to PDF in the destination configuration, Kofax Import
Connector actually converts all non-PDF parts of the message to an ISO-standardized version of PDF, the
PDF/A. However, Kofax Import Connector can also convert PDF parts to PDF/A.

Note the following:
• If Microsoft Office is selected as conversion tool in MS Office Documents, conversion of excel

documents will result in PDF documents rather than PDF/A documents.
• Conversion to PDF/A depends on the normalization capability of Aspose, the 3rd party product used

in Kofax Import Connector for this purpose. Given that and the complexity of the PDF/A document
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conversion in general, it cannot be guaranteed that compliance to PDF/A is achieved by 100 % for
every converted document.

Enabling Conversion to PDF/A for PDF Documents
1. Configure a destination. See Configure destinations for imported documents for the general

procedure.
2. On the Advanced Conversion and Import tab, select Normalize PDF documents to PDFA.
3. Click OK to save changes.
4. Click Restart Service.

Multiple instances of converters
To convert several documents in parallel, when multiple instances of KC Plug-In are running, run multiple
instances of converters simultaneously. These converters are KfxConverter, image2tiff.exe, convert.exe,
tcimgio datalogics. Configure the number of instances for each converter in the Create_Config.xslt file
available at C:\Program Files (x86)\Kofax\KIC-ED\MC\xcd (assuming default installation path
on a 64-bit operating system.)

To set the total number of parallel conversions for each type of converter, use MaxInstances and
SyncObject properties. By default, the value of MaxInstances property is three for each converter.

Note Running more than three instances of a converter can impact the system performance.

Prevent duplicate message import
To avoid duplicate message import, KC Plug-In provides a locking mechanism. In this, KC Plug-In create
files named with a unique ID returned by Message Connector in the ReceiveMessage call. The file is
created on a local or network folder as configured. This folder must be common for all the configured KC
Plug-In applications which polls the same Message Connector.

By default, KC Plug-In will use the folder defined in the Kofax Capture's registry key "ServerPath" as root
path and under the root path it will create a folder "KofaxImportConnector\LockFileStore".

Additionally, the path is also configurable at <LockStorePath> element of the Kofax Import Connector's
configuration XML file. If <LockStorePath> is configured, Kofax Capture's "ServerPath" registry key is
ignored. The registry key "ServerPath" is used only if the <LockStorePath> element is empty (default).

Initially, KC Plug-In verifies whether the file with the received ID already exists. If the file does not exist,
it will create the lock file and continue processing the message. The message gets the status "Retrieved
and queued". If the file already exists, KC Plug-In will check if the file is exclusively locked. If it is locked,
this means that another KC Plug-In instance is processing the message, therefore KC Plug-In will do
nothing with this message and continue fetching the next message.

Following is the list of codes and corresponding description of message status in the lock file.
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Code Description Result

10 Retrieved and queued Message has been retrieved from MC and is in KC Plug-In, in
the message queue waiting to be processed into Capture.

20 Processing into Capture The message is being imported into Capture. This status is
set after the create batch operation when the message files
are being imported.

30 Closing batch All messages have been imported and the close batch
operation is in progress

50 Import OK Close batch has successfully completed

60 Retry confirm - Confirm
failed and the Confirm call
is scheduled for retry (for
example, Message Connector
is down when KC Plug-In tries
to confirm the message)

Close batch succeeded, but Confirm message failed. KC
Plug-In instance that imported the message schedules five
more retries every five minutes.

70 Confirm Pending Retry Confirm did not succeeded for 5 times. The status is
updated to Confirm Pending and any KC Plug-In instance
that eventually receives a message with this ID will retry to
confirm it.

100 OK Close batch and Confirm message back to Message
Connector have successfully completed.

By default, the locking mechanism is disabled. To enable it, do the following:

1. Start the KC Plug-In configuration, open any connection and click OK.

2. Close the KC Plug-In configuration.

3. Edit the file C:\ProgramData\Kofax\KIC-ED\KCPlugIn\config\KIC-ED-KCPlugIn.xml
and search the element <LockStoreEnabled>. In <LockStoreEnabled>false</
LockStoreEnabled> replace 'false' with 'true'.
It should look similar to: <LockStoreEnabled>true</LockStoreEnabled>.

4. To avoid duplicates from Right fax, set the element <LockStorePreferSourceTransferID>
value to true.
It should look similar to: <LockStorePreferSourceTransferID>true</
LockStorePreferSourceTransferID>.

5. Save the XML file.

6. Restart KC Plug-In.

Note The lock folder path length (excluding the filename length) must not exceed 200 characters. It
assumes that the length of the RightFax Unique-ID (which is generally 15 characters) is less than 20
characters. In the unlikely case that the RightFax Unique-ID is longer, the maximum lock folder path
length decreases accordingly.

By default, the Kofax Import Connector will use the file path defined in Capture's registry key
"ServerPath". Under this path, it will create a folder "KofaxImportConnector\LockFileStore".
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Manage conversion time for large files
The default time specified for processing files may be less to process some large size files. In such
scenarios, to avoid timeout, user can increase the default conversion time.

Note In case of multiple instances of KC Plug-In, longer conversion time may cause duplicate imports.
To avoid duplicate import, refer locking mechanism.

To increase the timeout value, do the following:
1. Open the Create_Config.xslt file from C:\Program Files (x86)\Kofax\KIC-ED\MC\xcd

(default installation path on a 64-bit operating system.)
2. Increase the value of the <MaxTimeout> parameter under the <ConversionOptions> element.
3. If the <MaxTimeout> or <ConversionOptions> parameter is not available in the file, add these

parameters under the <TncDocConv> as shown in the following example.
<TncDocConv>
                        ...
                        <ConversionOptions>
                                    <MaxTimeout>1200000</MaxTimeout>
                        </ConversionOptions>
                        ...
</TncDocConv>

4. Save and close the Create_Config.xslt file.
5. Restart Message Connector.

Import XFA files
PDF documents with Adobe XML Forms Architecture (XFA forms) can be imported and converted using
Kofax Import Connector.

Adobe Experience Manager is required. The following prerequisites apply:

Note If support for Adobe LiveCycle is available, you can also use Adobe LiveCycle for conversion of
XFA Forms.

• Adobe Experience Manager server must be installed, configured, and accessible to Kofax Import
Connector. The Output service must be running and its web service enabled and working properly.

• Adobe Experience Manager software must be on a different computer than Kofax Import Connector.
However, we recommend to install it in the same network LAN segment (to decrease the probability of
timeouts and retries).

• The minimum supported version for Adobe Experience Manager is 6.3. Please contact Kofax Support
before upgrading to a new version. If you are using Adobe LiveCycle, the minimum supported version is
ES3.

• You must acquire the Adobe Experience Manager product through an appropriate Adobe Sales
Channel. Kofax does not ship, install, support or troubleshoot the Adobe Experience Manager. The
customer using this feature is responsible any licensing requirements and maintenance contract and/or
agreements required by Adobe and any of third party vendor that may be involved.
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Configuration steps in Kofax Import Connector:
1. In Message Connector, enter the information about connecting to the Adobe Experience Manager on

the Adobe Experience Manager tab.
2. In KC Plug-In, configure a destination: On the Advanced Conversion and Import tab, select

Convert XFA forms using Adobe Experience Manager.

Note Enabling this feature can negatively impact the performance. Each PDF document is sent to
document converter to determine if it is XFA form or standard PDF.

All limitations imposed by Adobe apply. For example, only XFA PDFs with no rights, signature, or
certification can be converted to PDF or PDF/A. See your Adobe Experience Manager documentation.

When an exception occurs while using Adobe Experience Manager, Kofax Import Connector reports the
same exception in its log file and the document is treated as a standard document conversion error.

Import MSG and EML files from folder
When you import MSG and EML files from a folder, these email messages are treated as received emails.
The metadata (such subject, to, from, date) are extracted directly from the email message. All content
selection and conversion options apply to the MSG or EML file. For example, converting to TIFF, adding a
message header, importing only body or attachments.

Note If you are not importing MSG and EML files from a folder directly, and using a controlling XML file
which links these email documents, only the email body is converted and imported. The attachments are
discarded, unless you select to include original content.

Registry settings to enable TLS v1.1 and TLS v1.2 support for
EWS

In Kofax Import Connector, for EWS to send TLS v1.1 and TLS v1.2 confirming requests and messages
to Microsoft Exchange server, modify/add specific registry keys for both client (Message Connector) and
Exchange Server.

Initially, you must install the required .NET Framework 3.5.1 updates to enable TLS v1.1 and TLS
v1.2. Use the appropriate links from the following table to upgrade .NET Framework for the applicable
Operating System in use.

Operating System (Server/Client) Web link

Windows Vista SP2 and Windows Server 2008 3154517

Windows 7 and Windows Server 2008 R2 3154518

Windows Server 2012 3154519

Windows 8.1 and Windows Server 2012 R2 3154520

Windows 10, version 1511 3156421
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Note If the .NET Framework update is already installed or if the update is not required (in case a higher
version of .NET Framework is already installed which support TLS v1.1 and TLS v1.2), following error is
displayed The update is not applicable to your computer.

To enable TLS, do the following for:
• Message Connector
• Exchange Server

Enable TLS v1.1 and TLS v1.2 for Message Connector
To enable TLS v1.1 on a computer where Message Connector is installed, add or modify the following
registry sub keys.

Operating
System
Type

Registry Path Sub key Type Description

64-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\.NETFramework\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

64-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\Microsoft\.NETFramework
\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

32-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\.NETFramework\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Client

DisabledByDefault dword Set this sub key
value to 0.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Client

Enabled dword Set this sub key
value to 1.

To enable TLS v1.2 on a computer where Message Connector is installed, add or modify the following
registry sub keys.

Operating
System
Type

Registry Path Sub key Type Description

64-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\.NETFramework\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

64-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\Microsoft\.NETFramework
\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

32-bit HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\.NETFramework\v2.0.50727

SystemDefaultTlsVersions dword Set this sub key
value to 1

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Client

DisabledByDefault dword Set this sub key
value to 0.
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Operating
System
Type

Registry Path Sub key Type Description

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Client

Enabled dword Set this sub key
value to 1.

Enable TLS v1.1 and TLS v1.2 for Exchange Server
To enable TLS v1.1 on a computer where Microsoft Exchange Server is running, add or modify the
following registry sub keys.

Operating
System
Type

Registry Path Sub key Type Description

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Client

DisabledByDefault dword Set this sub key value
to 0.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Client

Enabled dword Set this sub key value
to 1.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Server

DisabledByDefault dword Set this sub key value
to 0.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.1\Server

Enabled dword Set this sub key value
to 1.

To enable TLS v1.2 on a computer where Microsoft Exchange Server is running, add or modify the
following registry sub keys.

Operating
System
Type

Registry Path Sub key Type Description

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Client

DisabledByDefault dword Set this sub key value
to 0.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Client

Enabled dword Set this sub key value
to 1.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Server

DisabledByDefault dword Set this sub key value
to 0.

32-bit/64-
bit

HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Control\SecurityProviders
\Schannel\Protocols\TLS 1.2\Server

Enabled dword Set this sub key value
to 1.
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Note Note the following:
• Both server and client (Message Connector) sub keys must be enabled at Exchange Server. After

enabling the keys, restart the computer.
• To support this feature on Exchange Server 2013, install all the latest updates available for

Exchange Server 2013. Additionally, for Exchange Server 2013, install the CU16 update. Also, it is
recommended that latest updates for all exchange servers must be installed.

Certificates
This section lists two sample procedures for generating certificates for use with Message Connector and
KC Plug-In.

Request a certificate for Message Connector using Microsoft Active Directory
Certificate Services

In this example, we are using Microsoft Active Directory Certificate Services to generate a certificate
for Message Connector and OpenSSL to extract the private key and certificate. Review the following
requirements and tips.
• Microsoft Certification Services

• Server must be configured for https binding (https://[CAName]/certsrv/)
• Server must be configured to archive the key
• Create a template which allows to export the private key

• OpenSSL is used for
• Exporting a decrypted private key
• Creating a PKCS#12 file

1. Use Microsoft Certification Services to request a certificate:

a. Use a web browser to connect to the CA Server (https://CAName/certsrv).

b. Click "Request a certificate".

c. Click "advanced certificate request".

d. Click "Create and submit a request to this CA".

e. Fill out the form, select the correct Certificate Template and select "Mark keys as exportable".
Enter the correct Message Connector server name in the Name field (for Windows Failover
Cluster configuration, use the name of the clustered MC service).

f. Click Submit. Wait until the certificate is issued.

g. Click "Install this certificate". Wait until the certificate is installed.
2. Use Internet Explorer to export the certificate:

a. Go to Tools > Internet Options > Content > Certificates > Personal tab.

b. Select your certificate and click Export.
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c. Select to export the private key. Select PKCS #12 as the format.

d. Type a password to protect the key.

e. Specify the location and file name. Click Finish.
3. Use OpenSSL to extract the private key and the certificate to .pem format, e.g.:

openssl.exe pkcs12 -in "c:\certif.pfx" -out 
    "c:\certif.pem" -nodes

You will need to provide the password you used in step 2d.
4. Open the pem file in a text editor. In the file you will find the certificate and private key needed for

configuring Message Connector. Refer to Configure SSL connection.

Request a certificate for KC Plug-In using OpenSSL
In this example, we are using OpenSSL to generate a certificate for KC Plug-In.

1. Use OpenSSL to request a certificate (assuming Windows binary distribution of OpenSSL):

a. Generate an RSA private key.
C:\Openssl\bin\openssl.exe genrsa -out my_key.key 2048

This command generates a private key file with the file name my_key.key and the key length of
2048 bits.

b. Generate a Certificate Signing Request (CSR).
C:\Openssl\bin\openssl.exe req -new -key my_key.key -out my_request.csr -
config C:\Openssl\bin\openssl.cnf

This command uses the my_key.key to create the CSR my_request.csr.

c. Generate a self-signed public certificate based on the request.
C:\Openssl\bin\openssl.exe x509 -req -days 3650 -in my_request.csr -signkey
 my_key.key -out my_cert.crt

This command uses the private key and certificate signing request to create a self-signed public
certificate (my_cert.crt).

d. Generate a PKCS#12 file.
C:\Openssl\bin\openssl.exe pkcs12 -keypbe PBE-SHA1-3DES -certpbe PBE-SHA1-3DES
 -export -in my_cert.crt -inkey my_key.key -out my_pkcs12.pfx -name "my-name"

2. Start Certificates MMC Snap-In for computer account:

a. Start MMC, e.g. by running mmc.exe from the Start menu.

b. On the File menu, select Add/Remove Snap-In.

c. Click Add and select Certificates. Click Add again.

d. Select "Computer account". Click Next.

e. Select "Local computer". Click Finish.

f. Click Close, and click OK.
3. Install the certificate to the Personal\Certificates folder for computer account.
4. Display the details of the certificate and copy the value of its thumbprint into KC Plug-In

configuration. Refer to Configure KC Plug-In web service interface.
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5. Restart KC Plug-In.

Bcc field mapping
You can map the content of the Bcc field to Kofax Capture fields, however, there is a number of anomalies
that makes the field special.
• The Bcc field is populated only if the polling mail address is Bcc.
• At least one mapping must exist for Bcc.
• The visibility of the Bcc field is subject to the settings of the sending mail server.
• According to the standard, even if the sender specifies multiple Bcc recipients, the Bcc recipients see

only their own address.

Restrictions / known issues
• For EML and MSG files imported using the option "Include complete message as EML/MSG", the file

selected in Kofax Import Connector does not display Bcc field with some email clients.
• When performing the "Body with Message Header" conversion with KfxConverter:

• If the Bcc address is the same as the polling address, Bcc value is displayed in the converted file.
• If the Bcc address is different from the polling address, Bcc value is not displayed in the converted

file.
• When performing the "Body with Message Header" conversion with TotalMailConverter, Bcc is never

displayed.
• For email messages sent to identical To and Bcc recipients, the Bcc is not mapped.
• On some mail servers (for example gmail), when you send a message to the same To and Bcc

recipients, the originator of the same message receives the message as well when using POP3. If you
are using Kofax Import Connector to poll both sent and received mail, both messages are processed
independently (two separate batches).
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Operation and maintenance

This chapter contains information about operating and maintaining of Kofax Import Connector.

Start and Stop the KC Plug-In Service
The KC Plug-In service must be restarted after each configuration change to make the changes effective.

1. Start Kofax Capture Administration module from the Kofax Capture group in the Windows Start
menu.

2. On the menu, select Electronic Documents > Configuration.
3. On the Assistance Tasks menu, click one of the commands:

• Restart Service
• Start Service
• Stop Service

Note If no connection is marked active, the KC Plug-In service does not start.

Convert PST files
Personal storage table (PST) files are used by Microsoft Outlook and other Microsoft products to store
messages and other items. Use this procedure to extract all messages from a PST file to a folder. Kofax
Import Connector can then import the extracted messages to Kofax Capture.

1. Start Windows Command Prompt in the Message Connector installation folder (by default C:
\Program Files (x86)\Kofax\KIC-ED\MC\bin\KFXConverter\, assuming 64-bit operating
system).

2. Run the command
KFXConverter.exe –s <sourcepath>\<filename> –f <destinationpath>\ –type msg

As <sourcepath>, enter the folder where your PST file is located.
As <filename>, enter the name of the PST file to be converted.
As <destinationpath>, enter the folder where the MSG files should be extracted.

3. Wait until the extraction is complete.

You can now move the extracted files to a watched folder to import them to Kofax Capture. See Access
folders.
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Note MSG files where attachments have been removed by any Microsoft Outlook archive tool cannot be
imported.

Tip You can convert multiple PST files simultaneously. However, when running multiple KFXConverter
instances in parallel, some information about the second and later instances might be missing from the
log file. To ensure that your logs are complete, you can specify different log files for each instance using
the command line switch -logfile <logfilename>.

Message Connector Status Monitor
Message Connector provides a monitoring interface with the following main functions:
• Sending test messages
• Viewing documents in storage
• Managing failed documents
• Monitoring Message Connector status

Send test messages
Use this section if you want to verify the functionality of the Message Connector by sending a test fax or
email. Both tests work by sending a message in a loop (Message Connector -> Message Connector). KC
Plug-In will then import the message to Kofax Capture.

Send a test fax
1. Start Message Connector Monitor utility from the Kofax Import Connector group in the Windows Start

menu.
2. On the menu, click Test Fax.
3. In the Number to Dial, enter a number. For a test message this can be any number.
4. Click Send Fax.
5. Wait until the text "Server returned ok" is displayed.
6. On the menu, click Outbound > Processed. After some time you will find the sent fax. Optionally,

you can click Inbound > Pending and view the message there, if the KC Plug-In service is not
running. Otherwise, you will find the test fax in Inbound > Processed.

Send a test email
1. Start Message Connector Monitor utility from the Kofax Import Connector group in the Windows Start

menu.
2. On the menu, click Test Email.
3. In the To, enter an email address. For a test message this can be any address.
4. Click Send Email.
5. Wait until the text "Server returned ok" is displayed.

72



Kofax Import Connector Administrator's Guide

Message Connector storage
Message Connector stores all messages and files received from various sources to its internal storage
before they are imported to Kofax Capture.

The storage is managed automatically. Files and messages that are correctly imported to Kofax Capture
are marked for deletion and they are removed when the storage fills.

Files and messages that could not be correctly imported to Kofax Capture may fill the storage. Refer to
Manage failed messages manually.

The storage is divided into multiple folders:
• Click Inbound Status > Active to list active documents, i.e. documents that have been received by

Message Connector but not yet delivered to Kofax Capture. When the archive to folder function is
activated, documents remain in this folder until the archiving has been concluded.

• Click Inbound Status > Active > Failures to list documents that have been received by Message
Connector but could not be delivered to Kofax Capture. Documents appear this folder only if the
configuration setting Keep Failed is selected. When the archive to folder function is activated,
documents remain in this folder until the archiving has been concluded.

Note Documents remain in this folder until they are handled manually by an operator (reactivated or
deleted). If not monitored, this can cause full storage and stop processing of documents.

• Click Inbound Status > Processed to list documents delivered to Kofax Capture. If Keep Failed
is cleared, this folder also contains documents that permanently failed to import to Kofax Capture.
Processed documents are deleted automatically from the storage when space for active messages is
needed.

• Click Inbound Status > Processed > Failed to list documents that permanently failed to import
to Kofax Capture (Keep Failed must be cleared). As all processed documents, they are deleted
automatically from the storage when space for active documents is needed.

• Click Outbound Status > Active to list test fax messages which are queued for sending or are
currently being sent.

• Click Outbound Status > Processed to list test fax messages sent out by Message Connector, as well
as messages that could not be sent.

• Click Outbound Status > Processed > Failed to list test fax messages that could not be sent.

View messages in the storage
1. Start Message Connector Configuration utility from the Kofax Import Connector group in the

Windows Start menu.
2. On the menu, go to any of the storage folders (Inbound or Outbound).
3. Select the message and click View/Save .
4. Email messages are available as EML files and can be displayed with Outlook Express or Windows

Live Mail or any other mail client that supports EML. Fax messages are available in multipage TIFF
format (a special viewer might be required to view this format properly)
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Note You can also view EML files in Microsoft Outlook. In Outlook 2007, please follow these
instructions: http://support.microsoft.com/kb/956693. Outlook 2010 can open these files without any
additional effort.

Manage failed messages manually
Use this section if you want to manually manage messages that could not be delivered to Kofax Capture.
Depending on the Keep Failed configuration, problematic messages can be found either in the storage
folder Inbound > Active > Failures or Inbound > Processed > Failures.

Reactivate messages
In particular, it is important to monitor the Inbound > Active > Failures folder, as messages in this folder
can potentially fill in the entire storage. These messages can be reactivated and Kofax Import Connector
will retry to import them to Kofax Capture.

1. Start Message Connector Monitor utility from the Kofax Import Connector group in the Windows Start
menu.

2. On the menu, click Inbound > Active > Failures.
3. You can view the contents of a message to investigate the problem (click View/Save ).
4. Then either reactivate the message  or to delete it . A reactivated message is moved back to the

Inbound > Active folder. A deleted message is moved to folder Inbound > Processed > Failures.

Rerun messages
Messages in the Inbound > Processed > Failures folder are already marked for deletion. When the
storage gets too full, these messages are lost. However, as long as they are available, you can attempt to
rerun them, i.e., create a copy of the message in the Inbound > Active folder (as if it had just arrived).

1. Start Message Connector Monitor utility from the Kofax Import Connector group in the Windows Start
menu.

2. On the menu, click Inbound > Processed > Failures.
3. You can view the contents of a message to investigate the problem (click View/Save ).
4. You cannot delete these messages; they are already deleted. However, you can try to rerun the

message . A copy of this message is created in the Inbound > Active folder.

Monitor Message Connector
1. Start Message Connector Monitor from the Kofax Import Connector group in the Windows Start

menu.
2. On the menu, click Status.
3. In the right frame you can see the status of Message Connector and its internal components and

connections.
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Filter source IP addresses for SMTP connections
To provide additional security by allowing SMTP connection requests from authentic IP addresses and
avoiding/rejecting requests from unsolicited IP addresses, filters can be defined in Message Connector.

Note Filters are only applicable for requests from SMTP connections and requests from other
connection types such as HTTP are not filtered.

Using the Source IP Filter field in Email Inbound via SMTP tab, Message Connector provides an option
to define list of filters. Using these filters, SMTP connections to Message Connector are either allowed or
denied. By default, no filter is defined and connections are allowed from all IP addresses.

Each line in the Source IP Filter field defines a filter and starts with an Allow or Deny keyword followed by
the CIDR (Classless Inter-Domain Routing) notation of an IP range. These filters are compared with the
source IP address of a request. If a source IP address falls in a category of a filter starting with Allow, the
SMTP connection for that IP address is accepted.

For example, a filter Allow 10.20.30.0/24 allows request from IP addresses from 10.20.30.0 to
10.20.30.255. That is, any request from and source with IP address between 10.20.30.0 to 10.20.30.255
is allowed.

Additionally, if filters are defined but no filter matches with the incoming source IP address request, the
request is denied. Else, the first matching filter defines whether the request should be allowed or denied.

Use Kofax Monitor
Kofax Monitor can be used to monitor the operation of Kofax Import Connector. Web service interface is
used to provide information to Kofax Monitor.

The following counters are available for monitoring Message Connector.

Web Service Parameters Description

GetRunState Shows the run state of Message Connector.
• 0 = not running,
• 80 = storage full, no documents accepted into storage;

import to Kofax Capture continues
• 100 = running

GetStorageVisible Shows how full is the storage of Message Connector, in
percent.

GetMessagesFailed Shows the number of messages that could not be imported
to Kofax Capture and need to be processed.
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Web Service Parameters Description

GetMessagesWaiting MediaType Shows the number of messages waiting to be imported
to Kofax Capture per media type. The text parameter
MediaType may have to following values:
• ALL (default)
• FAX
• EMAIL
• FOLDER
• WEB-SERVICE

The following counters are available for monitoring KC Plug-In. Full description of the counters is available
in Kofax Import Connector Developers Guide.

Web Service Parameters Description

GetAllState Shows the state of feature licenses and a list of
connections.

GetConnection ConnectionName Shows if the specified connection is active and connected.

GetConnectionNames Shows the names of all connections.

GetFeatureLicenseState Shows the state of Kofax Import Connector feature
licenses.

You can use the Web Service Wizard from the Kofax Monitor Admin Console to set up these counters.
1. Start Message Connector Configuration utility from the Kofax Import Connector group in the

Windows Start menu.
2. On the General tab, enter the Own Computer Name.
3. Click Advanced and review the settings on the HTTP tab.
4. Click Save. Click Exit and restart service.
5. Start Kofax Capture Administration from the Kofax Capture group in the Windows Start menu.
6. On the menu, select Electronic Documents > Configuration and review the Web Services

Configuration. Restart KC Plug-In service if you do any changes.
7. Start the Kofax Monitor Admin Console.
8. Click Add Test Using Wizard and select Web Service Wizard.
9. Use the wizard to configure the counter.

a. Enter the Web Service WSDL, e.g.: https://messageconnector:25086/file/Monitor.wsdl or http://
kcplugin:8001/KIC-Electronic-Documents?wsdl. Use the information from steps 3 and 6.

b. Select one of the methods. Use only the web services listed in the table above.

c. Configure the details of the test. E.g., you can create a "Connectivity" test, using the
GetRunState method, with "100" as the expected response.

d. Click Add Test and conclude the wizard.
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Log files
Kofax Import Connector provides log files that can help with troubleshooting. Log files are stored in the
application / program data folder of all users. The exact path (<path>) depends on the operating system:
• C:\Documents and Settings\All Users\Application Data\Kofax\KIC-ED (Windows

Server 2003 and Windows XP)
• C:\ProgramData\Kofax\KIC-ED (Windows Server 2008, Windows Vista and later)

Manage logs in Message Connector
1. Start Message Connector Configuration utility from the Kofax Import Connector group in the

Windows Start menu.
2. Click Advanced to display additional configuration options.
3. Edit the settings on the Advanced tab.

• The default values (TraceLevel 10 and MessageTraceSize 1) provide basic trace information (that
is often sufficient) without negatively impacting performance.

• Troubleshooting values (TraceLevel 40 and MessageTraceSize 100000) provide lot of information;
these are more suitable when duplicating error situations in controlled environment.

Refer to Message Connector Help for more information about the parameters.
4. Find log files in <path>\MC\log
5. Click Save, then click Exit and restart service.

Manage logs in KC Plug-In
1. Go to the folder <path>\KC Plug-In\logconfig.
2. Open the file log4net.config in a text editor.
3. Edit the line starting with "<level value=". Use INFO for normal operation; use DEBUG for

troubleshooting.
4. Find log files in <path>\KC Plug-In\log.
5. Restart the KC Plug-In service to make the changes effective.

Manage logs in KFXConverter
The default name of the log file is KFXConverter.log. The default location is C:\ProgramData\Kofax
\KFXConverter. The maximum log file size is 5 MB. The file is overwritten when the maximum
size is reached. You can specify another log file using the command line option -logFile <path>
\<filename>, for example -logFile C:\temp\mylog.log.

For PDF/A normalization using Standard option in PDF to PDF/A conversion engine in Message
Connector, conversion results are logged in StandardPDFAEngine.log.
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Timeout Parameters
Kofax Import Connector provides many timeout parameters that can be modified and used when importing
and converting documents, such as very large size documents.

Note
• By default, all these timeout parameters are configured for optimum performance and consider most

user scenarios. Therefore, it is suggested to modify these parameters only in exceptional cases.
• Do not modify the other timeout parameters which are not mentioned in the below table.

Timeout
parameters

File name Default path Default Value Description

ImportTimeout Create_Config.xslt C:\Program Files
(x86)\Kofax\KIC-ED
\MC\xcd

3600s Time calculated from when the
message is touched and until
message is confirmed.
The message is locked during this
time.

Kofax_DocConver
sion_Timeout_Sec
onds

Kofax.Kcs.KcImpo
rt.exe.config

C:\Program Files
(x86)\Kofax\KIC-ED
\KCPlugIn\Bin

12000s Time calculated from when the
message is retrieved from storage,
converted and transferred to KC
Plug-in.
This timeout is applicable only
when the document conversion
is enabled in the KC Plug-in
configuration.

Kofax_No_Conver
sion_Timeout_Sec
onds

Kofax.Kcs.KcImpo
rt.exe.config

C:\Program Files
(x86)\Kofax\KIC-ED
\KCPlugIn\Bin

1200s This parameter includes time all
actions from when the message
is retrieved from storage, and
transferred to KC Plug-in.
This timeout is applicable only
when the document conversion
is disabled in the KC Plug-in
configuration.

MaxTimeout Create_Config.xslt C:\Program Files
(x86)\Kofax\KIC-ED
\MC\xcd

90000ms Maximum time allowed only for
document conversion.
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Troubleshooting

This section lists some of the error messages that you can encounter while using Kofax Import Connector.

Error message Description

Could not create batch Configured batch class does not exist in the Kofax Capture.
For example, this error occurs if a batch class is renamed or
removed while Kofax Import Connector is running and Kofax
Import Connector tries to send message to the destination
which is configured to use this particular batch class.
Note: Kofax Import Connector acknowledges the changes in
the batch only when they are published in Kofax Capture.
Any other eventual exceptions thrown by the KC import API.
Check log files for exception details.

Could not create document Configured document class does not exist in the batch. For
example, this error occurs if a document class is renamed or
removed while Kofax Import Connector is running and Kofax
Import Connector tries to send message to the destination
which is configured to use this particular batch.
Note: Kofax Import Connector acknowledges the changes in
the batch only when they are published in Kofax Capture.
Any other eventual exceptions thrown by the KC import API.
Check log files for exception details.

Could not create folder Configured folder class does not exist in the batch. For
example, this error occurs if a folder is renamed or removed
while Kofax Import Connector is running and Kofax Import
Connector tries to send message to the destination which is
configured to use this particular batch.
Note: Kofax Import Connector acknowledges the changes in
the batch only when they are published in Kofax Capture.
Any other eventual exceptions thrown by the KC import API.
Check log files for exception details.

Configured batch class does not exist
Configured document class does not exist
Configured folder class does not exist

Kofax Import Connector checks for the existence of all the
batch, document, and folder classes when the service starts.
If it doesn't find the configured batch, document, or folder
classes, it displays the error message. Note: This error is
displayed in KC Plug-In main window (in the bottom pane).

Could not login to Kofax Capture Incorrect user ID or password. Please refer to General
settings window of Kofax Import Connector.
Any other eventual exceptions thrown by the KC import API,
for example, insufficient permissions.
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Error message Description

Out of Kofax Capture scan licenses When the number of pages to import exceeds the license limit
supported by Kofax Capture, Kofax Import Connector throws
this error.

Kofax capture could not close the batch Any condition that would prevent the KC import API to close
the batch, for example when the message is empty (when
all pages were blank and VRS removed them) and there is
nothing to import into Kofax Capture.

Delayed due to shut down When Kofax Import Connector service is stopped while there
are messages in the queue, Kofax Import Connector shows
this status message.

Empty folder can't be created Folder with the folder class does not contain any documents.

Could not import image Could not import images When Kofax Capture rejects importing of an image, for
example, if the image is not in supported format.

Custom script execution failed When there is an exception thrown other than ScriptException
and ScriptIgnoreMessageException while executing a custom
script.

Xml input contains more than 1 batches When AutoXML is configured and the incoming XML contains
more than one batch tag. Note: The current Kofax Import
Connector limitation is one batch per imported XML file.

Xml mapping Xslt transformation failed When there is an error in performing XSLT transformation for
XML mapping, for example, XmlMapping.xslt provided for the
transformation file is not correct.

Xslt stylesheet missing (deactivate Xml mapping or
create the mapping stylesheet)

XmlMapping.xslt is missing in schemas/destination folder.

Stylesheet files for Xml mapping missing For each configured destination, a folder with the respective
files is created with the destination name at the location C:
\ProgramData\Kofax\KIC-ED\KCPlugIn\config
\Schemas. When any of these destination folders are deleted
and Kofax Import Connector tries to access the location, this
error is thrown.

Xml import failed XML import failed due to any unexpected issue. Check log
files for exception details.

Could not populate batch fields
Could not populate folder fields
Could not create table row
Could not populate document table field
Could not populate expected total field

An unexpected error occurred when filling the data to the
respective field in the batch. For example, the mapping field is
of different data type and is not compatible with the field that is
configured in the batch

Batch / folder / table row / table / expected total /
document field mapping failed. Mismatched
configuration

If Kofax Import Connector tries to import a specific field and
if the respective field doesn't exist in Kofax Capture, it throws
errors related to the missing fields.
For example, table does not exist in Kofax Capture. Auto
import XML tries to import a table but the definition does not
exist in the batch class in Kofax Capture.

Received <ImportSession> element corrupted (no
batch element available)

The AutoXML is invalid. The batch element is missing in the
XML document.
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Error message Description

Could not create batch with XmlAutoImport or
generic Xml mapping
Batch class required for XmlAutoImport or generic
Xml mapping does not exist
FormType required for XmlAutoImport or generic
Xml mapping does not exist
Folder class required for XmlAutoImport or generic
Xml mapping does not exist

BatchClassName or folderclass or FormType which is
specified in XML file (for autoXML or generic XML) is not
defined in the batch class in KC.
Any other eventual exceptions thrown by the KC import API.
Check log files for exception details.

Attachment is missing. The message could not
be imported into Kofax Capture due to message
reception error code.

When Kofax Import Connector is configured for Auto Import
XML, KC Plug-In tries to check the file list in XML to the files
that are imported from Message Connector.
If it finds any file is missing, it throws this error.

Could not create duplicate batch Kofax Import Connector rejects messages when a batch with
same name already exists in Kofax Capture. The following
settingsmust be configured so that Kofax Import Connector
rejects messages in this case:
• Set DuplicateBatchRenameOff in the Kofax Capture

registry (HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\Kofax Image Products\Ascent Capture\3.0)
to 1.

• Set Kofax_RejectOnDuplicateBatchName in
Kofax.Kcs.KcImport.exe.config to True.

Cannot create batch. File name is too long If the file name is too long (more than 260 characters), Kofax
Import Connector tries to rename the file to "Renamed.ext".
If the file name length still exceeds 260 characters, the
operating system cannot create the file.
Note: The file name here refers to absolute folder path + file
name. Workaround: Try to reduce the temp folder path.

The message could not be imported into Kofax
Capture due to a document conversion error. The
error is: Root Xml document could not be converted
as Xml rendering is disabled.

Message rendering option should be enabled for importing
XML file as PDF/TIFF. For example, if you configure XML
Import Connector compatible mapping, include original
content, and conversion to PDF/TIFF, message rendering
option should be enabled. If not, Kofax Import Connector
throws this error.

The message could not be imported into Kofax
Capture due to message reception error code.

When Kofax Import Connector is configured for AutoImport
XML, KC Plug-In tries to check the file list in XML to the files
that are imported from Message Connector. If it finds any file
is missing, it throws this error.
This error can be thrown also in other cases of reception error,
for example incomplete fax received.

The message could not be imported into Kofax
Capture due to message reception error level 2

Message was not received completely and ended with an
error. For example, if the received fax does not even contain a
single page. Check log files for exception details.

Reception error level 1 of message {0} Message was partially received and ended with an error. For
example if reception of a fax ended with an error, at least 1
page has been stored, but further pages may be missing.
Check log files for exception details.
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Error message Description

The message has no content Empty message

The message has no RootXml attachment The message has no RootXml attachment, but the destination
expects it.

The message has no body and no attachments Kofax Import Connector receives the message without
any content. It could also be a configuration issue, for
example, Kofax Import Connector is configured to process
only attachments and to ignore the body, but the message
contained only a body and no attachments.

The message could not be imported into Kofax
Capture due to a document conversion error

This error is shown when document conversion fails and if
Kofax Import Connector is configured to Reject message if
document conversion fails. Document conversion can fail due
to the following reasons:
• Respective conversion tool/software is not installed.
• The conversion tool itself is unable to convert the

document.
• VRS fails processing a document.
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